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Welcome to NetObjects 
nPower
NetObjects nPower™ is the essential tool for easily editing Web sites. Whether you 
are maintaining a site for a small business or a large corporation, you can use 
NetObjects nPower to keep your site up to date quickly and easily.

NetObjects nPower is a full suite of editing tools built for users of any technical 
skill level, combined with built-in controls and safeguards needed to make site 
updates safe and hassle-free.

With NetObjects nPower, if you are familiar with using word-processing software, 
then you are ready to edit your Web site—there’s absolutely no Web coding or 
HTML knowledge needed, so you can begin to make changes to your Web site 
immediately.

How to Get Started with NetObjects 
nPower
To ensure success as you start editing Web sites with NetObjects nPower, use the 
tools provided with the program to get started quickly.

In-Depth Information
This manual, NetObjects nPower User Guide, provides information on all 
NetObjects nPower features and functions, including editing text and graphics, 
creating links, managing a catalog, and using the Versions Manager.

Conventions Used in This Guide
NetObjects nPower often provides multiple ways to accomplish a task. Procedures 
in this guide generally include the most convenient method, but other methods are 
usually available. If you are most comfortable using menu commands, you will 
probably find the item you are looking for on a menu even if it is not explicitly 
included in the steps.
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For readability, this manual presents all file names, paths, file extensions, HTML 
tags, and URLs like this. Example names that you should replace with your own 
names appear in bold italic.

Both this manual and the online help assume you are proficient with Windows 98, 
Windows NT, Windows 2000, Windows ME, or Windows XP. If you need help 
using these systems, consult their respective user guides. This guide also assumes 
you are familiar with the World Wide Web and its terminology.
2



Getting Help
NetObjects nPower offers several options for getting online help.

For topic help, select Help Topics from the Help menu to launch the help system 
and display the table of contents.

Click to move 
forward and 
backward 
through a 
sequence of 
related topics

Click a book to 
see the topics it 
contains; click a 
topic to see 
specific 
information

Click to return to 
the last topic you 
viewed

Open this book to 
see keyboard 
shortcuts

Click the 
underlined text 
in an overview 
topic to jump 
to detailed 
information

To find information in the online topic help, click:

• a book on the Contents tab and then double-click a topic to see the information 
it contains.

Use the >> button to move forward through topics in sequential order.

Use the << button to move backward through the sequence.

Click the Back button to return to the last topic you viewed.

Look at the topics in the Quick Reference book to find keyboard shortcuts.

• the Index tab and enter a keyword related to your topic.

• the Search tab and type the word or phrase you want to search for.
3



To see information about a specific item in any NetObjects nPower window or a 
control in a dialog or palette:

• Right-click the object and then select What’s This? from the shortcut menu.

• Click the question mark icon in the title bar of a dialog or palette, then click the 
item you want to learn about.

In either case, an explanation of the item pops up.

You can also highlight a menu command, then press F1 for an explanation.
4



C H A P T E R  1
NetObjects nPower 
Basics 1
NetObjects nPower provides you with several navigational tools that simplify the 
site-management process. NetObjects nPower also has a wide range of features that 
will make keeping your Web site content up to date easy as well. Modifying 
content such as text, images, links, and tables is a breeze with NetObjects nPower 
and does not require any technical knowledge or Web site editing experience.

This chapter introduces NetObjects nPower, including information about:

• NetObjects nPower window

• Navigating in NetObjects nPower

• Choosing colors and working with color palettes
5



NetObjects nPower Page View
NetObjects nPower Page View
Use Page view to edit pages and add content. In Page view, you see the Layout area 
and MasterBorder of each page. The Layout area displays objects that are unique to 
that page. The MasterBorder contains objects that repeat on a set of pages, much as 
headers and footers appear in a word processing document. You can also preview 
the page as it will appear in a browser.

NetObjects nPower Window
When you retrieve your site and start NetObjects nPower, you will see the Page 
view window containing the Home page, the Standard toolbar docked under the 
Menu bar, and a Properties palette.

The title bar, menu bar, and tool bar are at the top of the NetObjects nPower 
window. The title bar shows the name of the current site.

Title bar 
Menu bar

Toolbar

Properties palette
6



Chapter 1 NetObjects nPower Basics
About the Properties Palette
When you click an object in Page view, the properties palette changes to display the 
properties available for that object. Properties appear on tabs that also might change 
when the selected object changes. For example, when you select a text box in Page 
view, the Text Properties palette shows a Text Box tab.

Text tab

When you double-click in the text box to edit the text, the Format tab is added to 
the display.

Format tab

To shrink the properties palette to display just its title bar, double-click the title bar 
or click the minimize button; do the same thing again to restore the full display. To 
completely hide the properties palette, click its close box. To show the palette 
again, from the View menu, select Properties Palette. A check mark on the menu 
indicates the palette is displayed.
7



Navigating in NetObjects nPower
About the Standard Toolbar
When working in NetObjects nPower, the Standard toolbar is docked below the 
Menu Bar in the Page view window.

You can move the toolbar by positioning the pointer over the double line at its top 
and dragging it anywhere in the window. To dock the toolbar, double-click its title 
bar or drag it to the left side or top of the window.

Position the pointer here and drag to move the toolbar

Triangle indicates tool is one of a group

A small triangle in the lower right corner of a tool button indicates the tool is one of 
a group. To see the entire group, point to the tool and hold down the left mouse 
button. A flyout containing the other tools in the group appears. As you move the 
pointer over each tool, a ScreenTip identifies the tool group and the name of the 
specific tool.

 
Draw tool flyout

To select a tool from a flyout, position the pointer over the tool and release the 
mouse button. The tool you select is displayed on the toolbar. For example, if you 
point to the Draw tool on the Standard toolbar and hold down the left mouse button, 
you can draw a rectangle, rounded rectangle, ellipse, polygon, or line.

To hide and show the toolbar, from the View menu choose Toolbars > Standard 
Tools. A check mark on the menu indicates a toolbar is displayed.

Using the Zoom Tools

 
Zoom tools

You can select the Zoom In or Zoom Out tool from the Standard toolbar in Page 
view. The Zoom In tool is a magnifying glass with a plus sign; the Zoom Out tool 
has a minus sign.

You can reverse the function of the current Zoom tool by holding down the Alt key. 
For example, if the selected Zoom tool is Zoom In, pressing Alt changes it to Zoom 
Out. When you release the Alt key, it becomes Zoom In again.

Navigating in NetObjects nPower
NetObjects nPower provides several navigation tools, including shortcut menus, a 
Site Navigation palette, and the Site Editor.
8
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Using Shortcut Menus
NetObjects nPower provides shortcut menus you open by right-clicking an item. 
The menu lists the commands you can use on the selected item. In Page view and in 
dialogs and properties palettes, you can right-click an item and select What’s This? 
from the shortcut menu to display a description of the item.

Right-click in Page 
view to see this shortcut 
menu

Using the Site Editor
NetObjects nPower’s Site Editor simplifies many common site-management tasks. 
To open the Site Editor, right-click in Page view and select Site Editor from the 
shortcut menu. You can also open the Site Editor by choosing Site Editor from the 
Edit menu. See “Working with the Site Editor” on page 21

Choosing Colors
In NetObjects nPower, whenever the properties palette includes a Color button, you 
can change the color of the selected object. For example, you can change the color 
of a text box or table.

1. To choose a color for a selected object:

2. Click the Color button in any properties palette where it is offered.

The Color Chooser appears.

3. Click the color you want to assign to an object in the Color Chooser. 

4. If the desired color is not shown in the Color Chooser, click More Colors to 
open the Color Picker.

Ensure that the Color Table is shown.
9



Working with Color Palettes
The name of the current palette is shown below the color display. When the 
Only Web Colors check box is checked, the palette is dimmed. The last 10 
colors you selected from the palette are displayed in the Recent Color boxes.

Current palette

Colors you used recently

5. In the Color Picker, select a color range by:

•Dragging the triangles along the slider.

•Clicking inside the color slider.

6. In the color field, click the color you want to assign to the object, or toggle 
outside the Color Picker dialog to select a color from the Page view window. 
When you toggle outside the Color Picker, the mouse pointer will change an 
eyedropper tool and can be used to select an color within your desktop work 
area.

When you select a color, the color rectangle to the right of the color slider 
shows the new color in the top section of the rectangle and the original color in 
the lower half of the rectangle, and HSB, LAB, RGB, CMYK, and HTML 
hexadecimal values are also displayed.

If you clear the Only Web Colors check box and select a color, you might see a 
warning that the selected color is not Web safe. To avoid unexpected results in 
your site visitors’ browsers, choose colors that are Web safe.

7. Click OK.

The new color appears in the selected object.

Working with Color Palettes
When you choose colors for the objects in your site, you select from the palette 
offered in the Color Picker. You can use the Browser Safe Palette, which contains 
10



Chapter 1 NetObjects nPower Basics
colors that are Web safe, the system palette used by Windows, a palette you import 
from another application such as Adobe Photoshop, or a custom palette you create.

Choosing a Color Palette
1. Click the Color button in any properties palette where it is offered.

The Color Picker appears.

2. Select a palette from the drop-down list at the top of the dialog. If you choose 
Custom Palette and want to load an existing custom palette, see “Loading a 
Custom Color Palette.” To create your own custom palette, see “Creating or 
Editing a Color Palette.”

The palette is displayed in the Color Picker until you change it.

3. Click OK.

Loading a Custom Color Palette
1. Click the Color button in any properties palette where it is offered.

2. In the Color Chooser, click More Colors to open the Color Picker.

Ensure that the Color Table is shown. 

3. In the Color Picker dialog, clear the Only Web Colors check box.

4. Select Custom Palette from the drop-down list at the top of the dialog.

5. Click Load.

6. In the Open dialog, navigate to the palette you want to use, then click Open.

This palette is displayed in the Color Picker until you change it.

7. Click OK to close the Color Picker.

Creating or Editing a Color Palette
1. Click the Color button in any properties palette where it is offered.

2. In the Color Chooser, click More Colors to open the Color Picker.

3. In the Color Picker dialog, clear the Only Web Colors check box.

4. Select Custom Palette from the drop-down list at the top of the dialog.
11



Working with Color Palettes
A blank palette appears.

5. Click a box in the palette area.

6. Set the HSB, LAB, RGB, or CMYK values for the color you want to add to the 
palette, type the hexadecimal (HTML) value for the color, or double-click the 
blank box and choose or create a color in the Color dialog.

7. Repeat steps 5 and 6 for each color you want to add to the palette.

8. Click Save.

9. In the Save As dialog, type a file name for the palette and click Save.

The new palette is displayed in the Color Picker until you change it.
12



C H A P T E R  2
Setting Application 
Options 2
Application option settings affect how you work with your site in NetObjects 
nPower. You can change settings, such as browser font settings and update 
intervals, by choosing Application from the Tools menu. Changes take place as 
soon as you click OK to close the Application Options dialog.

This chapter explains how to set:

• Application options

• Preview options

• Text options

• Update options
13



Setting Application Options
Setting Application Options
• From the Tools menu, choose Application.

The Program tab of the Application Options dialog appears.

Program tab

• Auto save. When this option is selected, your site is saved each time you change 
pages and when you close NetObjects nPower. If you clear the Auto save check 
box, be sure to save your site periodically by choosing Save Site from the File 
menu.

• Application window maximized at startup. If you clear the check box for this option, 
the NetObjects nPower window opens in the last size you set, rather than full 
screen size.

• Open to most recently used file at startup. When this option is selected, the last site 
you worked on opens automatically when you start NetObjects nPower. If this 
option or Open to most recent view is cleared, you see Online view when you 
start NetObjects nPower.

• Open file to most recent view. If this option is selected, when you open a site, it is 
displayed in the last view you worked in.

• Use small fonts in properties palette. If you clear this check box, you see larger 
properties palettes in Page view. To maximize the area available for your page 
Layout, leave this option selected.
14



Chapter 2 Setting Application Options
• Compact database upon exit. This option is selected by default. Compacting the 
files can save you substantial hard disk space. In addition, when this option is 
selected, NetObjects nPower performs an error-checking procedure to verify 
your database as it compacts the files. It is recommended that you do not change 
this setting. 

Warning:Do not shut down Windows while the file is being 
compacted. This could cause your file to become 
unstable.

Setting Preview Options
• From the Tools menu, choose Application and click the Preview tab.

Installed browsers 
are shown here

Preview tab

• Select previewing default. When you install NetObjects nPower, it lists the 
browsers installed on your system. If installed browsers are not listed, you can 
add them to the list. Choose the Web browser you want to use for previewing 
sites by selecting its check box. To change the browser used for previewing, 
return to this dialog and choose a different browser.

To add a browser to the list, click Add. In the New Browser dialog, type a name 
for the browser, browse to the shortcut or .exe file that launches it, and click OK.

To remove a browser from the list, select it in the list and click Remove.
15



Setting Preview Options
To change a browser’s name or location, select the browser in the list and click 
Edit. Enter the new information and click OK.

• Preview scope. Choose whether you want to preview only the current page or the 
entire site you are working on when you choose Preview from the File menu. 
Previewing the entire site takes longer, but you can move from page to page in 
the browser to test the site’s navigation buttons. Select the Current page option 
to preview only the current page. When you select Current page, links to other 
pages are disabled. You can also preview the current page by clicking the Page 
Preview tab in Page view.

You can use keyboard shortcuts to preview either the whole site or just the 
current page or section:

• If Entire site is selected in the Applications Options dialog, pressing Alt+P 
or clicking the Preview Site button previews the entire site; pressing 
Ctrl+Alt+P or clicking the Preview Site button while pressing Ctrl previews 
just the current page.

• If Current page is selected in the Options dialog, pressing Alt+P or clicking 
the Preview Site button previews the current page; pressing Ctrl+Alt+P or 
clicking the Preview Site button while pressing Ctrl previews the entire site.

• Window size. Select the window size or resolution most appropriate for your site 
visitor’s monitors. This opens a preview window sized to the resolution you 
select so you can see how site visitors will view your site.
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Setting Text Options
• From the Tools menu, choose Application and click the Text tab.

Text tab

• Browser font settings. To ensure that your pages appear in your browser the way 
you see them in NetObjects nPower, choose the same font settings in your 
browser that you use in your site. For example, if you use Times New Roman, 
size 12, and Courier New, size 10, for your browser proportional and fixed 
width fonts, choose the same fonts and sizes in NetObjects nPower. The 
suggested settings are the defaults used by Microsoft Internet Explorer and 
Netscape Navigator when they are installed. 

NetObjects nPower sizes text boxes based on the expected font size, so when 
you change sizes, you change the Layout of the page slightly.

• Automatically select entire word. If this option is selected, when you start to drag the 
mouse pointer over a word, NetObjects nPower automatically selects the entire 
word and the space after it.

• Smart spell check. If this option is selected, after NetObjects nPower checks 
spelling of a text block, it does not check the same text again unless you modify 
the text or clear this option.

• Check spelling as you type. If this option is selected, NetObjects nPower will check 
the text as you type, and then mark possible errors with wavy underlines. To 
make a correction, right-click on the word and select the correction you want.
17



Updating NetObjects nPower
• Display report message. If this option is selected, after NetObjects nPower spell 
checks the page or site, you will see the number of corrections made. If you find 
this option unnecessary, you can check the “Don’t display again” box after 
spell-checking your page.

Updating NetObjects nPower
• From the Tools menu, choose Application and click the Updates tab.

Updates tab

Set your preferences for checking for online program updates. Select 
Automatically to check for updates using the frequency and event you specify, or 
Manually to check only when you select Check for Updates from the Tools 
menu. Automatically is the default setting.

If you select Automatically:

• Select an update frequency of Daily, Weekly, or Monthly.

• Choose when you want to check for updates. Select:

• Launches to search for updates each time you start NetObjects nPower.

• Connects to the Internet to search for updates when you connect to the 
Internet while using NetObjects nPower. This is the default setting.
18



C H A P T E R  3
Managing Your Site 3
Once you retrieve and open your Web site, you will your Home page will display in 
NetObjects nPower’s Page view. Page view is where you view and modify the 
content of your site. NetObjects nPower also includes a Site Editor that you can use 
to modify the navigational structure of your site, change page names, and add new 
pages. NetObjects nPower’s easy-to-use palettes and tools allow you to begin 
editing your site immediately, even without knowledge of HMTL or Web site 
editing experience. 

This chapter describes the process of opening your site, working in Page view, and 
using the Site Editor and its automated site-management capabilities, including:

• Retrieving your site for the first time

• Opening your site from the Project List

• Working with the Site Editor

• Selecting pages

• Adding, copying, deleting, and moving pages

• Renaming pages

• Assigning custom names
19



Retrieving Your Site for the First Time
Retrieving Your Site for the First Time
To retrieve your site for the first time, you will need to access the .nfc file for your 
site. The .nfc file contains the information necessary to retrieve your site for editing 
and publish your changes to the Web.

1. Locate the .nfc file for your site.

If you have not already saved this file on your hard disk, right-click on the .nfc 
file, select Save As from the shortcut menu, and specify a location for saving 
the file.

2. Double-click the .nfc file.

You will be prompted to give your Web site project a name.

3. Enter a site name in the Save Site As dialog.

4. Click Save.

NetObjects nPower will retrieve and open a working copy of your Web site for 
editing.

Note: When your site is open, it is statused as “In Use” by NetObjects 
nPower. If an “In Use” site is by another user, NetObjects nPower 
alerts the user that the site is already open so that site changes will 
not be overwritten.

Opening Your Site from the Project List
Once you have retrieved your Web site using the .nfc file and exited NetObjects 
nPower, you can launch the application from the Windows Start menu. When you 
launch NetObjects nPower from the Windows Start menu, the Online view page 
will display. The Online view contains a list of your site projects from which you 
can open your site for editing.

1. From the Windows Start menu, select Programs>NetObjects>NetObjects 
nPower 1.0, or double-click the NetObjects nPower icon on the desktop.
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Chapter 3 Managing Your Site
The Online view appears.

Click a site 
project name to 
open it

2. In the Site Projects section near the top of the Online view, click on the project 
name of the site you want to open.

Your site will open in Page view where you can edit its content.

Working with the Site Editor
The Site Editor displays the SiteStructure. In the Site Editor, the structure of your 
site is represented by page icons. As in a family tree, pages have parent, child, and 
sibling relationships. The Site Editor also contains a Properties palette with a Name 
tab, a Management tab, and a Meta Tags tab, where you can add and edit 
information for each specific page.

The Site Editor simplifies common site-management tasks. You can use the Site 
Editor to select the page you want to edit, move pages in the SiteStructure, and add 
new pages to your site. 
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Working with the Site Editor
To open the Site Editor, right-click on a page and select Site Editor from the 
shortcut menu.  

Name tab

Management 
tab
Meta Tags tab

In the Site Editor, the structure of your site is represented by page icons. As in a 
family tree, pages have parent, child, and sibling relationships.

The pages named Mission, Events, 
Next Tour, and Contest are children of 
the Home page and siblings of each 
other. The Events page is the parent of 
Activities and Highlights and the 
Contest page is the parent of Wonder 
Lodge

In the Site Editor, you can add pages to the site, rename pages, move them, copy 
them, delete them, and complete other site-oriented actions.

Selecting a Page
Before you can edit, copy, rename, or move pages, or set page properties, you must 
select a page. By selecting a page, you identify it as the one you will work with. 
NetObjects nPower highlights the title of the selected page. By default, your Home 
page will display in Page view when you launch NetObjects nPower.

To select a page:
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Chapter 3 Managing Your Site
1. Open the Site Editor by right-clicking in Page view and selecting Site Editor 
from the shortcut menu.

2. In the Site Editor, click the name of the page you want to select.

Press the arrow keys to select the current page’s parent, child, or sibling pages.

3. Click Go To Page.

Adding a Page
When you add pages to your site, NetObjects nPower automatically generates 
blank pages with a visual style that is consistent with your site’s other pages.

1. In Site Editor, click the page you want to be the parent of the new page.

2. Click New Page.

In the Site Editor, the new page appears beneath the selected page. The new 
page is named Untitled followed by a number, which indicates the order in 
which new pages were added.

3. Enter a name for the page in the Page name field of the Page tab.

Copying and Pasting Pages
You can copy pages in the Site Editor and paste them anywhere in the 
SiteStructure.

1. In the Site Editor, select the page or pages you want to copy and click Copy.
23



Working with the Site Editor
2. Select the page to be the parent of the copied pages and click Paste.

The copies are pasted into the SiteStructure as children of the selected page.

Deleting a Page
1. In Site Editor, select the page or pages you want to delete.

2. Click Delete Page.

3. Click Yes to confirm the deletion.

If you delete a page that has children, the child pages move up to the level of the 
deleted page.

Note: Deleting a page cannot be undone. You cannot delete the 
Home page. You also cannot delete a page if it has been 
protected from deletion.

Moving a Page
When you move pages, NetObjects nPower updates all affected links within the 
site. If you move a page that has children, the pages retain their relationship.

1. In Site Editor, select the page you want to move.

2. Drag the page to the target page, where it becomes a sibling, a child, or a parent 
in its new location.

As you drag the page, a red horizontal line appears above or below the target 
page to indicate the position on the SiteStructure where the page will be moved 
when you release the mouse button.

Note: You cannot move a page in the SiteStructure if protection options 
have been set so that the page cannot be moved.

Renaming Pages
When you publish your site, NetObjects nPower uses the page name as the HTML 
file name for the page. It also uses the page name when it creates links to the page.

If you give two pages the same name and they are published in the same folder, 
NetObjects nPower adds a numeral to the file name when it generates the HTML 
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Chapter 3 Managing Your Site
files for the second and any additional pages. For example, if you have two pages 
named Great, NetObjects nPower creates Great.html and Great1.html.
25



Setting Properties
You can change the name in the Page name field on the Page tab of the Site Editor.

To rename a page in the Site Editor:

1. Open the Site Editor.

2. Select the page you want to rename.

3. Edit the text in the Page name field on the Page tab of the Properties palette.

Using Custom Button and Banner Names
By default, banners and navigation buttons use the page name. If you prefer, you 
can specify different names. If you have a long page name, you can break it into 
two lines.

To specify custom page names:

1. Select the page you want to work with.

2. Select Custom Names from the Edit menu.

3. In the Custom Names dialog, type the custom names you want to use.

• Navigation button. Appears on navigation buttons leading to this page. To add 
a second line of text, press Enter after the first line.

• Banner. Appears in the page’s banner. To add a second line of text, press 
Enter after the first line.

4. When you finish entering names, click OK.

Setting Properties
Pages have properties. Some properties affect the published site; others are for your 
information only. You can instruct NetObjects nPower not to publish a particular 
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Chapter 3 Managing Your Site
page, note if a page is done, and enter comments about the selected page. And you 
can use META tags to include information about specific pages on the site.

Setting Page Properties
You set the following properties on the Page tab of the Properties palette in the Site 
Editor:

• Page name. Name assigned to the page that is used on the page icon in the 
banners and navigation bar buttons generated by NetObjects nPower. See 
“Renaming Pages” on page 24.

• Page title. Text that appears in the title bar of the browser window when it 
displays this page. When site visitors bookmark this page, the page title is used. 
The title is also emphasized in search engine queries.

• Custom Names. See “Using Custom Button and Banner Names” on page 26.

• Page type. Shows whether the page is a normal page or a stacked page. You 
cannot change this setting; it is determined by how the page was created.

• Exclude From Navigation. Removes the page from the site navigation. The page is 
published and typically accessed using links.
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Setting Page Management Properties
Click the Management tab of the Properties palette in the Site Editor to set the 
following properties:

• Done. Marking a site as Done is a convenient way to manage individual pages in 
a large site. This setting has no effect on the functioning of the site. 

• Don’t publish. Makes it possible to publish some pages while not publishing 
others that might be under construction or private.

NetObjects nPower removes pages marked Don’t publish from the navigation 
bars of other pages in the site, disables manually created links to such pages, 
and does not generate these pages during publishing. However, you can preview 
a page that is designated Don’t publish as an individual page.

Do not use the Don't publish setting in an attempt to publish only changed pages 
to an already-published site. Doing so causes broken links and other undesirable 
results. Instead, you can publish a section of the site to update it.

• Comments. Enter notes about the status or content of individual pages.

Setting META Tag Properties
You can use META tags to include information about a page within the HTML 
<HEAD> tag of each page in the site. For example, you might want to include 
keywords to promote your site with the various search engines, the site author’s 
name, or copyright information. Site visitors do not see information included in a 
META tag.
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Chapter 3 Managing Your Site
To set META tags on a page:

1. In the Site Editor, select the page you want to work with.

2. Click the META tag tab.

 

3. Select a META tag from the drop-down list. You can select:

• Abstract to provide a brief summary or abstract of your Web page.

• Author to declare the author of the Web page.

• Contact Address to provide contact information for inquiries related to your 
Web page, including the name and e-mail address of the Webmaster or 
company.

• Copyright to declare copyright information for your Web page.

• Date to declare the date your Web page was created.

• Description to provide a general description of the contents of your Web 
page.

• Distribution to declare the level of distribution for your Web page and how 
it should be classified in context to the World Wide Web. Levels of 
distribution include local, global, and internal use.

• Expires to declare a date and time after which the Web page information 
should be considered expired.

• Generator to declare the tool used to build your Web page. 

• Keywords to list a series of keywords representing the content of your site.

• Language to declare the language used on your Web page.
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• Public to declare if the Web page is available for public viewing.

• Rating to declare the content level of your Web page to screen out 
inappropriate viewers.

• Refresh to declare the number of seconds before your Web page is 
refreshed.

• Revisit-After to declare the number of days a search engine should revisit 
your Web page.

• Robots to declare to search engines what content on your Web page to index 
and spider.

4. Click on the text field and enter your content.

5. To apply the same META tag to some or all of your Web pages:

• Enter a META tag to the Home page, then select “Apply META tags to all 
pages” on the META tag tab. The META tag will appear on all pages.

• Enter a META tag to a page other than the Home page, then select “Inherit 
META tags from parent” from the META tag tab. The META tag will 
appear on all child pages of the parent page. 

If you make changes to META tags on the child page, the inherited META tags 
will no longer apply.

6. Repeat the process for one or all of the available META tags.
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Saving Changes and Closing Your Site
By default, NetObjects nPower automatically saves your site each time you change 
pages in Page view, unless you turn the Auto save feature off. After you have made 
changes to your site, you should select Save Site from the File menu to save your 
changes before you preview or publish your site.

You can close your site by selecting Close Site from the File menu. When you close 
your site without creating a version in the Version Manager, a dialog will display 
giving you the option to create a version before closing your site. The dialog also 
gives you the option of keeping a site labeled as “In Use” if you intend to finish 
editing it at a later time.

After you have saved your site and are finished making changes, follow the steps 
for previewing and publishing your site. See Chapter 17, “Publishing Your 
Changes”
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Saving Changes and Closing Your Site
32



C H A P T E R  4
Page View Basics 4
Page view is where you edit text, graphics, and other objects to modify page design 
and add content. You can use a variety of tools, object properties, and layout aids, 
such as rulers, guides, and grids, to add and arrange objects on the page.

This chapter describes:

• MasterBorder and Layout area

• Setting up the Page view display

• Displaying pages in Page view

• Adding objects to the page

• Editing objects

• Positioning objects
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Exploring Page View
Exploring Page View

Layout area

MasterBorder 
area

Page name

Docked 
toolbar

Properties 
palette

Rulers
34



Chapter 4 Page View Basics
MasterBorder and Layout Area
In NetObjects nPower, a page consists of a Layout area and a MasterBorder area. 
The Layout area is the body of the page. It contains objects that are unique to that 
page. The MasterBorder is the page margins. MasterBorders contain objects, such 
as navigation bars, that appear on multiple pages.

Setting Up the Page View Display
Use the Palette Launcher buttons in the lower left corner of the NetObjects nPower 
window to open and close the Properties palette, Site Navigation palette, and 
Object Tree palette. 

See “NetObjects nPower Window” on page 6, “Using the Site Navigation Palette” 
on page 37, and “Using the Object Tree Palette” on page 44.

Properties palette

Object Tree palette

Site Navigation palette

Use the commands on the View menu to show or hide Page Design view elements.

• Show and hide palettes and toolbars as described in “NetObjects nPower 
Window” on page 6.

• Use the MasterBorder command to hide the MasterBorder. This provides more 
on-screen area for you to work on the page Layout.

• Use the Page Labels command to show and hide the Layout and MasterBorder 
labels and margin lines.

• Display object outlines to help you control object size and position.

• Use the Object Icons command to display or hide the indicator icons.

• Link icon indicates the object has an associated link.

• Anchor icon indicates the object has an anchor point to which you can link.

• Script icon indicates the object has associated HTML or scripts.

• HTML tag icon indicates the text has an HTML tag inserted at this point.
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Displaying Pages in Page View
• Embedded object icon indicates the embedded object’s insertion point.

• Action icon indicates an action is associated with the object.

• Warning icon indicates a potential layout problem or other error condition. 
A ScreenTip identifies the problem. You cannot hide this icon.

• Question mark icon indicates an empty navigation bar. You cannot hide this 
icon.

• Lock icon indicates that certain aspects of the page or site element have 
been protected by the site’s designer.

• Select Rulers & Guides from the View menu to show and hide rulers and 
guides.

• Select Grid from the View menu to show and hide grids.

Setting Page Properties
To display the Page Properties palette, from the View menu, select Page View 
Options and click the Page tab. See “Setting Page Properties” on page 27.

Displaying Pages in Page View
You can move between pages using the Site Navigation palette.
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Using the Site Navigation Palette
The Site Navigation palette displays the SiteStructure.

 
Site Navigation 
palette button

1. In Page view, click the Site Navigation palette button.

The Site Navigation palette appears.

2. Double-click the page you want to open.

NetObjects nPower displays the page you select.
37



Changing Page Size
Layout Width and 
Height fields

MasterBorder 
handle

MasterBorder 
handles

Layout area 
handle

Layout area handle

Changing Page Size
To resize the Layout and MasterBorder areas:

With the rulers showing, drag a Layout or MasterBorder handle to change the area’s 
height and/or width. Use the far right MasterBorder handle to change the size of the 
right MasterBorder and the bottom MasterBorder handle to change the size of the 
bottom MasterBorder.

To set Layout size precisely, enter values in the Layout Width and Height fields on 
the General tab of the Layout Properties palette. 

You cannot make a Layout smaller than the objects it contains. You cannot lock the 
size of a Layout. If you add an object that is larger than the Layout, the area 
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expands to accommodate the object. If you are working with Windows 98, or ME, 
the upper limit for a Layout area is 33,000 pixels by 33,000 pixels.

Understanding Protected Content
While working in Page view, you may see a padlock icon on an object or Properties 
palette. This icon indicates that certain attributes of the object have been protected 
against changes. Protection options are applied to an object using the NetObjects 
Fusion Web-site-building software. When editing your site with NetObjects 
nPower, you can only modify those attributes of a page or site element that have not 
been protected.

For example, if protection options have been set so that an image on the site cannot 
be copied, a padlock icon will appear in the upper left-hand corner of the properties 
palette when the image is selected, and the Copy and Paste options will not be 
available on both the shortcut menu and the file menu.

Padlock icon indicating the 
object has been protected

MasterBorders, Layouts, Banners, Navigation Bars, images, and text boxes may 
have certain protection options applied to them. In addition, an entire page or the 
entire site may be protected to prevent changes. When editing your site, you can 
only change objects and attributes within the site that are not protected.
39



Adding Objects to the Page
Adding Objects to the Page
You can use the tools on the Standard toolbar, or drag and drop files onto the page 
to place objects.

Using Object Tools
1. In Page view, select the tool you want to use.

2. Draw a box to position the object.

For some objects, you must select a file from the Open dialog.

The object appears on the page with the appropriate properties palette. The 
options displayed on the properties palette vary depending on the object.

3. Set the object properties.

After you use a selected tool to place an object on the page, the Selection tool 
automatically becomes active. To use a tool repeatedly to add several objects, 
double-click it to keep it active.
40



Chapter 4 Page View Basics
The Standard Toolbar
The Standard Toolbar includes tools for easily adding text boxes, images, tables, 
and more.

The Standard Toolbar

Hotspot tools
See Chapter 11 

Zoom tools
See Chapter 1

Draw Shape tools
See Chapter 9

Span tool
See Chapter 

Link tool
See Chapter 11

Selection tool
See Chapter 1

Table tools
See Chapter 10 

Anchor tool
See Chapter 11

Picture tool
See Chapter 7

Line tools
See Chapter 9

Text tool 
See Chapter 6

Dragging and Dropping Objects
1. In Windows Explorer, select the file you want to place.

You can drag and drop any file you can place with an object tool.

2. Drag the file into the NetObjects nPower window and drop it on the page.

3. Set the object’s properties.

Reusing Assets
By treating object files as assets, NetObjects nPower provides you with a 
convenient way to replace or update multiple instances of an object. Instead of 
adding multiple copies of a file in several locations, you add the asset once and then 
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select from the list of existing assets when you want to place another instance of the 
asset.

To place an asset:

1. In Page view, choose the appropriate tool and draw a box to specify where you 
want to place the asset.

The File Open dialog appears.

2. Click the Assets tab to see a list of current assets.

Create backup of 
Picture check box 
saves a copy of the 
original picture in 
assets

3. Select the asset you want to place and click Open.

NetObjects nPower places the asset on the page and opens the appropriate 
properties palette.

Adding and Modifying Alt Tags
To make pages load faster, some visitors set up their browsers so they do not 
display images. To ensure that your pages provide the information you want to 
convey regardless of how the site visitor’s browser is set up, use alt tags to provide 
descriptive text that appears when images are not displayed. You can add an alt tag 
to an image or drawn shape, in the AltTag field of the properties palette.
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Microsoft Internet Explorer 4.x and greater and Netscape Navigator 4.x display alt 
tag text in a ScreenTip when site visitors point at an object, so make sure every alt 
tag is appropriate for a ScreenTip.

AltTag field

To add or modify an alt tag:

• On the object’s Properties palette, type a descriptive name in the AltTag field.

Editing Objects and Assets
You can edit objects created in other software applications from within NetObjects 
nPower. In Page view, right-click the object and select Open File In External Editor 
from the shortcut menu. 

Selecting an Object
In NetObjects nPower you might not always be aware of making a selection, but in 
Page view something is always selected. To find out what is selected at any time, 
check the properties palette.

Using the Selection Tool

 
Selection tool

• Click the Selection tool on the Standard toolbar.

• Click an object to select it. Click elsewhere to deselect it.

• Drag a marquee around multiple objects, or Shift+Click each object you 
want to select. Shift+Click selected objects one-by-one to deselect them.
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Using the Object Tree Palette
The Object Tree palette provides a convenient way to select objects, especially if 
you are working with layered or hidden objects.

 
Object Tree palette

1. In Page view, click the Object Tree palette button in the lower left corner.

The Object Tree palette appears. 

2. Click an object in the Object Tree palette to locate it on the page.

Selection handles appear around the object on the page.

Renaming an Object
If you add several of the same type of objects to a Layout or MasterBorder, 
NetObjects nPower numbers each object in the order in which you placed it. You 
can rename the objects for easy identification. These names are only for use by 
NetObjects nPower; they do not affect the final Web site.

 
Object Tree palette

1. In Page view, click the Object Tree palette button in the lower left corner.

The Object Tree palette appears.

2. Select the name of the object, then click again and type a new name. Some 
objects cannot be renamed.

Resizing an Object
• Click an object and drag the selection handles to resize the object.
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Positioning Objects
Moving or Copying an Object
• Click and drag an object to move it.

• Press Ctrl, then click and drag an object to copy it.

• To prevent an object from dropping into a container, such as a text box, select 
the object and press Alt while moving it over a container.

• You can move or copy objects from Layout to Layout in Page view using the 
Cut, Copy, and Paste commands on the Edit menu.

To specify the position of an object before you paste it, click the page and then 
use the Paste command. The upper-left corner of the pasted object appears at 
the point where you click the page.

Aligning and Distributing Objects
In a Layout, you can align two or more objects to each other and distribute three or 
more objects equidistant from each other. You can also align and distribute objects 
relative to the Layout.

1. In Page view, select the objects you want to align by Shift+Clicking each one or 
by drawing a marquee around objects in the Layout.

If you select different types of objects, the Multi-Object Palette appears. If the 
object properties appear, click the Position tab.
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2. If you want the objects to align or be distributed relative to the Layout in which 
the objects are placed, select Relative to Layout.

3. In the Align section, specify the horizontal and vertical alignment. 

When aligning objects, NetObjects nPower uses the object furthest in the 
direction you specify as the reference point. For example, if aligning left, the 
leftmost object is used; the topmost object is used when aligning top. When 
centering objects, NetObjects nPower chooses the average distance between the 
selected objects as the center point.

• Select an option from the Horizontally section to align objects’ left or right 
sides, or to center them. If you select Relative to Layout, the objects align to 
the right or left side of the Layout, or are centered in the Layout, one on top 
of the other.

On the left, the objects are 
aligned horizontally to the 
left; on the right, the 
objects are aligned the 
same way relative to the 
Layout

• Select an option from the Vertically section to align objects’ top or bottom 
sides, or to center them. If you select Relative to Layout, the objects align to 
the top or bottom of the Layout, or are centered in the Layout side-by-side.

• Select Horizontally or Vertically from the Distribute section to make 
selected objects equidistant. 

Adding, Moving, and Deleting Guides
Use the page guides to align objects vertically and horizontally. You can add as 
many guides as you want to either the MasterBorder or the Layout area. 
MasterBorder guides are red and Layout area guides are blue. Guides associated 
with a MasterBorder appear on all pages that use that MasterBorder. Guides you 
create are saved with the site. To:

• Add a guide, select the Layout or MasterBorder, and click in the ruler or hold 
down the Ctrl key while you drag an existing guide.

• Move a guide, click its arrow on the ruler and drag it.
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• Delete a guide, click its arrow and drag it off the ruler.
• Show or hide a guide, select Rulers & Guides from the View menu.

Aligning Objects Using Smart Guides
Use the smart guides to position an object vertically and horizontally without using 
page guides. Smart guides are convenient when you want to align one image or 
object with another that is already set. 

• To show smart guides, select Smart Guides from the View menu.
• To use smart guides, select and move an object in Page view. 

Smart 
Guides

Object 

Snapping Objects to Grids, Guides, and Each Other
Use the Snap feature to align objects exactly. When you select a Snap to command, 
NetObjects nPower creates a “magnetic” attraction between the selected object and 
the grid, guide, or other objects.

To force objects to snap to:

• Guides, select Snap to Guides from the View menu.
• Grids, select Snap to Grid from the View menu. 
• Other objects, select Snap to Object Outlines from the View menu.
Make sure the item you are snapping to is visible in Page view. See “Setting Up the 
Page View Display” on page 35.
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C H A P T E R  5
Working with Text 
Boxes 5
A text box is a container for text as well as other kinds of objects, including 
pictures, and tables. When you add a text box as a container, you do not have pixel-
level control over embedded objects. For example, you do not insert a picture in a 
text box and drag it into position. Instead, you embed the object at a selected point 
in the text and adjust its placement using alignment, positioning, and text-wrapping 
choices.

This chapter describes:

• Adding a text box

• Selecting a text box

• Embedding objects in a text box

• Wrapping text around objects

• Sizing a text box

• Setting text box background
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Adding a Text Box

 
Text tool

1. Select the Text tool from the Standard toolbar.

2. Drag a box in the location where you want to place the text box.

The text box appears with hollow selection handles indicating you can enter and 
format text. See See “Adding Text to a Page” on page 58

Selecting a Text Box
• To add or edit text within a text box, double-click in the text box. The text box 

selection handles are hollow, and the Text Properties palette includes a Format 
tab in addition to the Text Box tab.

• To work with a text box as a container, click the text box. The selection handles 
are solid, and the Text Properties palette displays the Text Box tab.
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To add and format text, see Chapter , “Adding Text to a Page.”

Embedding Objects in a Text Box
When you embed an object in a text box, a wide border appears around the box and 
the insertion point appears as a vertical bar.

Text box with wide border

Insertion point

The insertion point indicates where the object’s HTML tags are inserted when 
NetObjects nPower generates the HTML.

 
Insertion marker

NetObjects nPower positions pictures at the insertion point. Text, tables, and other 
objects are placed with the top edge lined up with the top edge of the text line 
containing the insertion point. You use the object’s alignment options to arrange 
the object within the text box. An insertion marker indicates the object’s insertion 
point.

Insertion marker

Embedded image aligned with 
Left wrap setting
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Embedding Objects in a Text Box
To move an embedded object, drag it. To place an embedded object on the top line 
of the text box, drag it until its insertion marker is positioned before the first text 
character.

Insertion marker positioned 
before the first text character

Embedded image aligned 
with Left wrap setting

You can create a new object in a text box or insert an existing object.

Dragging and Dropping an Existing Object
1. In Page view, select the Text tool from the Standard toolbar and draw a text 

box.

2. Add text. See Chapter 6, “Editing Text.”

3. Select an object elsewhere on the page and drag it into the text box.

The thick blue text box boundary indicates the object will be embedded.

4. Position the insertion point at the place in the text where you want to insert the 
object and drop the object.

5. Position the object within the text box. See “Wrapping Text around Objects.”

Creating a New Embedded Object
1. In Page view, select the Text tool from the Standard toolbar and draw a text 

box.

2. Add text. See Chapter , “Adding Text to a Page.”

3. Select the appropriate tool to create the new object. 

Note: To embed a text box within a text box, you must create it 
outside the text box and drag it into place.
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4. Position the mouse pointer in the text and draw a box for the new object.

If appropriate, the Open file dialog for that type of object appears. Select the 
object you want to embed and click OK.

5. Position the object within the text box. See “Wrapping Text around Objects.”

Wrapping Text around Objects
Once you embed an object in a text box, you can wrap text around it.

1. In Page view, select the object embedded in the text box.

The object’s properties palette appears.

2. Click the Align tab.

3. Set the alignment options.

Depending on the type of object you selected, NetObjects nPower displays 
some combination of the following alignment options:

• Vertical alignment of the object to the top, middle, or bottom of the text line.

• Horizontal alignment of the object to the left, center, or right of the text box, 
without text wrapping.

• Horizontal alignment of the object to the text box, with text wrapping. If you 
select Left wrap, the text wraps around the right side of the object; if you 
select Right wrap, the text wraps around the left side of the object. To 
embed the object at the top left of the text box, move the pointer to the 
beginning of the text.
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Sizing a Text Box
• In the Space around object section, specify the amount of vertical and 
horizontal space you want to leave between the image and the text.

The text wraps around the object according to your specifications.

Sizing a Text Box
When you create or select a text box, you can control its width, the minimum 
height, and the scaling of the text box to the full width of the Layout area or the 
browser window.

1. In Page view, select a text box or add a new text box.

The Text Properties palette appears.

2. Click the Text Box tab if necessary.

Text Box tab

3. To set the width of the text box, select it and drag the handles to size the text 
box as needed.

4. To set a minimum height for the text box, select Lock height and drag the text 
box handles to the minimum height you want.
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If Lock height is not selected, NetObjects nPower automatically adjusts the 
height of a text box to fit the text and objects it contains. Selecting Lock height 
prevents the text box from getting smaller in the site visitor’s browser.

Setting Text Box Background
You can add colors and pictures to text box backgrounds. If you choose a .gif with a 
transparent color, the text box background color will show through.

1. In Page view, select the text box and click the Text Box tab on the Text 
Properties palette.

2. In the Color field, select:

• Automatic to set the background to the color of the page background.

• Transparent to set the background to the background color specified by the 
parent object of the text box. For example, if a small text box is embedded in 
a larger text box with a red background, the small text box will also have a 
red background if Transparent is selected.

• Color to select a background color from the Color Picker. The selected color 
appears in the box to the right of the Color field. To change the color, click 
the box and select a new color from the Color Picker.

3. In the Image field, select:

• Automatic to set the background to the site’s default background image.

• None to eliminate the background image.

• Browse to select an image from the Open dialog. See “Choosing an Image 
Format” on page 82. If the picture is smaller than the text box, the browser 
tiles the image. To change the image, click the Browse button to the right of 
the field.
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C H A P T E R  6
Editing Text 6
Text is the primary tool for delivering your message. You can edit existing text, add 
text onto your pages, and format text for maximum impact. In addition to editing 
and adding text, you can also create and apply text styles to keep your site design 
consistent.

This chapter describes:

• Adding text to a page

• Formatting text

• Working with text styles

• Creating and formatting lists

• Inserting symbols

• Creating and editing fields

• Checking spelling

• Finding text

• Replacing text

• Counting words, lines, paragraphs, and characters
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Adding Text to a Page
To add text to a page, you can use the Text tool, drag and drop text from another 
application, paste text from the Clipboard, or import text. In each case, the text is 
placed in a text box. See Chapter 5, “Working with Text Boxes.”

When you add text to a page, it’s a good idea to add all your text and then go back 
and apply formatting.

Using the Text Tool

 
Text tool

1. In Page view, select the Text tool from the Standard toolbar and draw a text box 
on the page.

A text box and the Text Properties palette appear. Hollow selection handles 
indicate the text box is in text editing mode.

2. Type or paste text into the box.

The text automatically wraps to the width of the box.

To force a line break, position the insertion point at the end of the line and press 
Shift+Enter.

3. Click outside the text box to deselect it.

The text box sizes vertically to the text you enter. 
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Dragging and Dropping a Text File
1. In Windows Explorer, locate the text file you want to add to the page.

2. Drag the file onto the page.

The text appears on the page in a text box.

Pasting Text from the Clipboard
1. Cut or copy the text from the original source, such as a word processing 

document.

2. In Page view, click where you want to position the text.

3. From the Edit menu, choose Paste or Paste Special. Select:

• Paste to paste the contents of the Clipboard onto the current page. You 
might lose some of the original text formatting when you copy and paste 
text from the Clipboard.

• Paste Special to retain formatting. You can select:

• Formatted Text (RTF) to insert the contents of the Clipboard as text with 
font and table formatting.

• Unformatted Text to insert the contents of the Clipboard as text with no 
formatting.

• HTML Format to insert the contents of the Clipboard as HTML format.

To select the Paste Special default, click Set Paste Default and choose one of 
the three options.
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Formatting Text
You can format selected text using the options on the Text Properties palette or by 
applying formats to entire paragraphs.

Formatting Selected Text
With NetObjects nPower you can reformat selected text to change the text font, 
size, color, and style, as well as the paragraph alignment and indent. You can 
format selected characters in text boxes or table cells.

1. Double-click the text box that contains the text.

Hollow selection handles appear around the text box.

2. To select:

• Specific characters, drag over those characters.

• A word, double-click the word.

To select words quickly, you can set your options to automatically select the 
entire word. See “Setting Text Options” on page 17.

• A paragraph, triple-click in the paragraph.

• A block of text, click the first character, then Shift+Click the last character.

• Multiple paragraphs, drag through them.

3. Make sure the Format tab on the Text Properties palette is selected.

Format tab

4. Select a font from the drop-down list on the Text Properties palette.
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5. Select a font size from the drop-down list on the Text Properties palette.

The relative settings (-2 to 4) set the font size relative to the site visitor’s default 
browser settings. To change the unit of measurement, you can type directly into 
the Size field; for example, 12 pt.

 
Font style buttons

6. Click a font style button to assign characteristics—bold, italic, underline—to 
the text.

7. To assign a color, click the color sample and select a color from the Color 
Picker. 

8. To remove all added formatting from the paragraph containing the selected text, 
click the Clear button. Inherited formatting remains.

 
Alignment buttons

9. To set left, center, right, or block alignment for the paragraph containing the 
selected text, click an alignment button.

 
Indent buttons

10. To indent the paragraph, click an indent button or press Tab. Using this 
indenting button nests the selected paragraph under unselected paragraphs. To 
nest the paragraph to a deeper level, continue to click the button or press Tab. 
Default indenting is set as part of the text’s format style.

You can also assign list formats and text styles to selected text. See “Creating 
Bulleted and Numbered Lists” on page 72 and “Working with Text Styles” on 
page 70.

Formatting Paragraphs
Using the options in the Paragraph Settings dialog, you can set formats for the text 
in a paragraph, the paragraph alignment, spacing, margins, indents, paragraph 
border, and paragraph background.

When you format paragraphs, type all the text first and then go back and apply the 
formatting. If you set formats as you enter the text, new paragraphs inherit the style 
of the paragraph before it.

Formatting Text in a Paragraph
1. Position the insertion point in the paragraph you want to format. You do not 

need to select text.

2. On the Format tab of the Text Properties palette, click the Format button.
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3. In the Paragraph Settings dialog, click the Character tab.

Character tab

4. Set the text format options. If you choose Automatic, the settings for the parent 
style pass through to the paragraph.

• Font applies the text font; the list of fonts is derived from the font map in the 
\NetObjects System folder.

If the specified font for the formatted text is installed on the site visitor’s 
system, HTML 3.x-compatible browsers display your text using this font. If 
the font is not installed, the browser checks a substitution table. If the 
specified substitution is not possible, the browser uses its default font. You 
can change the substitution table by editing the fontmap.txt file in the 
\NetObjects System folder.

• Style applies a style to the text. You can select italic, bold, or bold italic.

• Size sets the size of the text. You can choose the unit for specifying the font 
size from the drop-down list to the right of the size field.

You can choose any size up to 22192 pt., but the actual font and size site 
visitors see is based on their browser default setting and therefore is 
unpredictable. Also, some older browsers do not support all sizes. For those 
reasons, it is best to use the relative settings (such as -2 to +4). Then, when 
site visitors increase or decrease their browser font sizes, text size also 
increases or decreases. But if you use an absolute font size such as points, 
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inches, or picas, the text on your pages stays the same size even if site 
visitors want to see it larger or smaller.

• Color applies color to the text. The color box shows the current text color. To 
change the color, click the color box and select a color from the Color 
Picker.

• Letter case sets the case (uppercase or lowercase) of the text. Use the 
Capitalize option to set initial caps, which capitalizes the first letter of each 
word in the text. Choose None to remove a letter case format set at a higher 
level.

• Small caps sets the text to appear in all small caps. If small caps is selected, it 
overrides the Letter case setting. Not all browsers support small caps. 
Choose None to remove a small caps format set at a higher level.

• Position sets the text to be subscript or superscript. Choose Normal to remove 
a position format set at a higher level.

• Decoration sets the text to the selected decorations. You can select underline, 
overline, and strikethrough.

Setting Paragraph Alignment, Spacing, and Margins
1. Position the insertion point in the paragraph you want to format. You do not 

need to select text.

2. On the Format tab of the Text Properties palette, click the Format button.
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3. In the Paragraph Settings dialog, click the Paragraph tab.

Paragraph tab

4. Set paragraph format options. If you choose Automatic, the settings for the 
parent style pass through to the paragraph.

• Alignment sets the alignment to left, center, right, or block. Changing 
alignment here also changes the alignment setting on the Text Properties 
palette. If no button is selected, the text is aligned using the default 
alignment.

• Image wrap sets how text can wrap around an image. You can choose left, 
right, or on both sides of the image. To apply wrap settings to a particular 
image, use the Picture Properties palette. 

• Line height sets the amount of space between lines of text in the selected unit 
of measurement.

• Letter spacing sets the amount of space between characters in the text in the 
selected unit of measurement.

• Space above and Space below set the amount of space above and below 
paragraphs in the selected units of measurement.
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• First line indent sets the tab space indent for the first line of text in the selected 
unit of measurement. This is the only way to indent a paragraph without 
using the space bar.

• Left margin and Right margin set the margins on either side of the paragraph in 
the selected units of measurement.

Setting Borders and Padding
Borders are lines around a paragraph. Padding is the amount of space between the 
border lines and the text. If no border is set, padding can mimic margins around 
text.

This text is inside a border. The 
padding is the space between the 
text and the borders.

Border
Padding

Note: Browsers can interpret your border and padding settings 
differently. Check the appearance of objects with borders and 
padding in different browsers to make sure the object appears as 
you intended.

1. Position the insertion point in the paragraph you want to format. You do not 
need to select text.

2. On the Format tab of the Text Properties palette, click the Format button.
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3. In the Paragraph Settings dialog, click the Borders tab.

Borders tab

4. Select border settings. If you choose Automatic, the settings for the parent style 
pass through to the paragraph.

• Automatic applies the default border setting.

• None prevents the parent element’s border settings from being applied.

• Border makes the other options available so you can apply individual border 
settings. Use:

Style, Width, and Color to set the border’s line style, width, and color. Click the 
Color box to select a color from the Color Picker.

Active borders to specify which borders appear around the paragraph. All four 
segments are selected by default, which adds a complete box around the 
paragraph. You can click any combination of segments.

5. Select the amount of padding you want at each side of the paragraph.

Setting Background Options
1. Position the insertion point in the paragraph you want to format. You do not 

need to select text.
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2. On the Format tab of the Text Properties palette, click the Format button.

3. Click the Background tab.

Background tab

4. Set the background format options for the paragraph. If you choose Automatic, 
the settings for the parent style pass through to the paragraph.

• Color sets the background color behind the text. Click the Color box to select 
a new color from the Color Picker. 

• Image sets the background to an image. Click Browse to select an image. 

• Attachment sets the background image to either remain fixed or scroll as the 
text scrolls. This option applies only to Microsoft Internet Explorer 4.x.

• Repeat sets how the image displays behind the text. Choose None to display a 
single image that does not repeat. Select Both to fill the background entirely 
with the image. Select Horizontal or Vertical to display a row of images 
horizontally or vertically behind the text.
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• Image Position sets the initial position of the background image. This feature 
is supported by Internet Explorer 3.0 and higher, but is not supported by 
Netscape Navigator 4.7 or earlier. To set the position to a specific value, 
select Value from the Horizontal and Vertical drop-down lists and enter a 
value for the position in the selected unit of measurement. 

To position the image correctly in browsers, the horizontal and vertical 
values interact. Note that when you change the setting for the horizontal or 
vertical position, the other setting changes accordingly.

Formatting Text Objects within Paragraphs
A text object is a portion of text that you can treat as a single unit. For example, a 
link is a text object. When you create a link and format it, you apply formatting 
features to the link as a single unit. If you apply a color, it applies to the entire link, 
not just a few letters. Paragraphs are also text objects because you can format them 
as a single unit without formatting the entire text box that contains the paragraph.

Paragraphs can contain links and other text objects. When you format a paragraph 
containing another text object, some—but not all—of the new formatting is also 
applied to the contained object. Generally, the formatting is consistent with the type 
of object and the formatting available for it. For example, links do not have 
margins, so if you change the paragraph’s left and right margins, the link is not 
affected. But because the font of a link can be formatted, if you format the 
paragraph’s fonts the link’s fonts are also formatted. However, if the link’s font has 
already been defined, it will not take on the paragraph’s font.

If you change the format of the contained object, it does not affect the container 
object. So, if you change the color of the link text, the surrounding paragraph text is 
not affected.

The following table shows which text attributes affect a contained object and which 
do not.

Text attribute Affects contained 
object

Does not affect 
contained object

Font x

Style x

Size x

Color x

Position x
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Case x

Decoration x

Small caps x

Alignment x

Image wrap x

Line height x

Letter spacing x

Word spacing x

Space above x (relative size 
corresponds to parent 
element’s width)

Space below x (relative size 
corresponds to parent 
element’s width)

First line indent x

Left margin x

Right margin x

List style x

List indent x

All border and 
background attributes

x

Text attribute Affects contained 
object

Does not affect 
contained object
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Working with Text Styles
A text style is a predefined set of formats for the characters, paragraphs, lists, 
borders, and backgrounds of text. Text styles provide a convenient way to specify, 
replicate, and update paragraph formatting for a text selection.

You can create text styles or modify the text styles included with NetObjects 
nPower. You can also create custom styles to use in conjunction with the styles on 
the Styles list.

Applying a Text Style to a Paragraph
1. In Page view, position the insertion point in the paragraph to which you want to 

apply a text style.

2. In the Paragraph section of the Text Properties palette, select a text style by 
clicking the Text Style icon. The text changes to the new style.

For example, if the original text is the Normal(P) style, and you select the 
Heading 1 (H1) style for the text, the entire paragraph changes to the H1 style.

Applying a Style to a Text Span
A span is a selection of text that you format as a unit. You can assign a custom style 
or other formats to the characters included in a span to differentiate that text from 
the rest of the paragraph. For example, if you want your company’s name to always 
appear in bold italic, you can create a custom style specifying those attributes. Then 
you select each instance of the company name as a span and apply the custom style. 

You can achieve the same result by selecting the text and manually formatting it 
from the Properties palette, but when you use a span you can apply a custom style 
quickly and then change it globally if necessary.

To create a span:

1. In Page view, select the text you want to format.

 
Span tool

2. Click the Span tool on the Standard toolbar.
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The New Span dialog appears.

3. Select a custom style from the drop-down list, or click the Format button and 
apply formatting to the selected text.

4. Click OK.

To remove a span, position the insertion point in the span, click the Span tab on the 
Text Properties palette, and click Remove Span.
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Creating Bulleted and Numbered Lists
To create a simple numbered or bulleted list:

1. In Page view, select the text you want to format as a numbered or bulleted list.

 
List type buttons

2. Click a list type button on the Text Properties palette to select a numbered list or 
a bulleted list.

When you click a list type button, NetObjects nPower applies the default 
Ordered or Unordered List style. To change the style, see “Formatting a List” 
on page 73.

3. To add an item to the list, press Enter at the end of a line. Press Shift+Enter to 
start a new line under the same bulleted item.

To remove the list style from the selected list level, click the List tab on the 
Properties palette and click Remove List.

To create a multi-level numbered or bulleted list:

1. In Page view, select the text you want to include in the list. Make sure each item 
in the list is a separate paragraph.

2. Click a list type button on the Text Properties palette.

3. Select the paragraph or paragraphs you want to make subordinate and click the 
right indent button or press Tab.

Each click of the indent button moves the selected paragraphs over one level in 
the list and adds the appropriate bullet or list character for that level. 
72



Chapter 6 Editing Text
Formatting a List
1. In Page view, select any text in a numbered or bulleted list.

2. Click the List tab on the Text Properties palette.

List tab

3. Click the Format button.

The List Settings dialog appears.
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4. Set the List style. If you choose Automatic, the settings for the parent style pass 
through to the list.

• Bullet. Select a bullet character or type of numbering from the drop-down 
list.

• Bullet Image. To use a graphic as the bullet character, click Browse and select 
the image you want.

5. Set the Line indent.

• Automatic applies the indenting of the object that contains the list whenever 
the list text wraps to a second line. The amount of the indent is preset.

• All lines indents all lines in each listed item to the same position.

• First line only indents the first line of each item in the list, but not the other 
lines.

6. Click OK.

Setting the List Start Value
If you select a numbered list and want it to start with a value other than 1 or A, you 
can define a new start value. 

To set a new start value:

1. In Page view, select any level in the numbered list. New start values only apply 
to numbered lists, not bulleted lists.

2. Click the List tab on the Text Properties palette.

3. In the Start Value box, enter a new start value, or click the up and down arrows 
to set the new value.

All entries at that level of the numbered list now conform to the new start value. 
For example, if you change the start value to 3, the first entry at that level is 
labeled 3, and the next entry is labeled 4.
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Setting the List Bullet or Numbering Type
You can choose a type of numbering or bullet character for each level of a list.

To set a new bullet or numbering type:

1. In Page view, select any level in the list.

2. Click the List tab on the Text Properties palette.

3. From the Bullet type drop-down list, select the type of bullet character or 
numbering you want for that level of the list.

The text styles associated with lists are List, Ordered <OL>, List, Bulleted <UL>, 
and List Item <LI>. Selecting the type of bullet character or numbering 
automatically selects the proper text style from the ordered or bulleted list. 
Changing the <LI> style affects both types of lists.

Note: Lists are formatted with bullets based on the List Item <LI> style; 
however, you can also format lists using other styles, such as 
Normal <P>. In that case, the list will not have a bullet character 
associated with it. Conversely, if you type a series of paragraphs 
and want to make them a list, you can apply the List Item <LI> 
style to the paragraphs.

Inserting Symbols
You can insert special symbols, such as an em dash or copyright symbol into text.

1. In Page view, double-click the text box containing the text where you want to 
insert the symbol.

2. Click the location in the text where you want to insert the symbol. 
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3. From the Text menu, select Insert Symbol.

4. In the Insert Symbol dialog, select a symbol and click Insert.

The symbol appears in the text.

You cannot edit the list of symbols.

Checking Spelling
You can check the spelling of English language words in NetObjects nPower. You 
can add words to a personal dictionary so they will no longer be flagged as 
misspelled. Your personal dictionary is a simple text file, so you can use any text 
editor to add or delete words. You can check spelling throughout an entire site, on 
selected pages, or on a single page.

If smart spell check is turned on, once NetObjects nPower checks spelling in a text 
block, it does not check the same text again unless you modify the text or turn off 
smart spell check. See “Setting Text Options” on page 17.

1. From the Tools menu, choose Spell Check.

2. Select:

• Current Page to check the spelling of text only on the page displayed in Page 
view.

• Entire Site to check the spelling of text on all pages in the site.

If NetObjects nPower does not recognize a word, it displays it in the Not in 
Dictionary field of the Spelling dialog. 
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Email addresses and URLs are not checked. 

3. Click:

• Options to choose a language, and to choose a location for your personal 
dictionary.

• Ignore to skip this instance of the word.

• Ignore All to skip all instances on this page.

• Change to replace this instance with the word in the Change to field.

• Change All to replace all instances on this page with the word in the Change 
to field.

• Add to put the word in your personal dictionary.

• Suggest to see alternate spellings for the word. Double-click a suggestion to 
use it.

• Cancel to cancel the spelling check.

Finding Text
1. From the Edit menu, choose Find.

The Find and Replace dialog appears.

2. In the Find in field, select a scope for the search. 

The options vary depending on the selected object.  
Select:

• Entire site to search all text in the site

• Current page to search text on the page currently displayed in Page view.
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• Current text box to search text in the text box currently selected in Page view.

• Selected text to search only the text currently selected in Page view.

3. In the Find what field, type the word, letters, or phrase you want to find.

4. Select options to narrow the search.

5. Click Find Next.

NetObjects nPower searches for the text.

Replacing Text
1. From the Edit menu, choose Replace.

The Find and Replace dialog appears.

2. In the Find in field, select a scope for the search. 

The options vary depending on the current view and the selected object.  
Select:

• Entire site to search all text in the site

• Current page to search text on the page currently displayed in Page view.

• Current text box to search text in the text box currently selected in Page view.

• Selected text to search only the text currently selected in Page view.

3. In the Find what field, type the word, letters, or phrase you want to replace.

4. In the Replace with field, type the replacement text.

5. Select options to narrow the search.

6. Click Find Next.

7. Click Replace to replace the found text, or click Replace All to replace all 
instances of the text with the replacement text.
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Counting Words, Lines, Paragraphs, and 
Characters
• To get a count for the current page, in Page view, choose Word Count from the 

Tools menu.

If the text box includes embedded objects, the line count is incremented for 
each embedded object.
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C H A P T E R  7
Editing and Adding 
Pictures 7
Using pictures and images on your site is an effective way to enhance your Web 
site’s message while increasing its visual appeal. You can enhance your pages by 
placing pictures in the Layout area and MasterBorder. This chapter tells how to add 
pictures and modify their size and appearance.

This chapter describes:

• Choosing an image format

• Adding a picture

• Using the Picture Properties palette

• Resizing and Rotating images

• Adjusting an image’s color
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Choosing an Image Format
To display a picture, most browsers require the picture to be stored in one of the 
following Web-standard formats:

• Joint Photographic Experts Group (.jpg) supports 24-bit true color.

• Graphics Interchange Format (.gif) supports 8-bit, 256-color images. NetObjects 
nPower also supports GIF 89, a format for transparency, interlacing, and 
animation, as well as animated .gifs. An animated .gif file contains multiple 
images that a browser plays in sequence, adding movement to your pages 
without browser plugins.

• Portable Network Graphics (.png) supports any color-depth image. To view .png 
images with Netscape Navigator 4.0, the PNG Live 2.0 plugin is required; 
Microsoft Internet Explorer 4.0 does not require a plugin. Earlier versions of 
both browsers require PNGLive 1.0 to view the image. You can find this plugin 
at http://home.netscape.com/plugins/image_viewers.html.

If you try to place a picture that is in .bmp, .pcx, .pct, or .psd format, NetObjects 
nPower offers to convert it to .gif or .jpg format. NetObjects nPower copies the file, 
converts the copy, and stores the copy in the site’s \Assets folder.

Adding a Picture

 
Picture tool

1. In Page view, choose the Picture tool from the Standard toolbar, and click 
where you want to position the upper left corner of the picture.

The Picture File Open dialog appears.

2. Select the image file you want from your hard disk or LAN, or select an image 
already in use in the site from the Image Assets tab.

You can do advanced image editing such as set the size, and color depth in 
NetObjects nPower. See “Using the Picture Properties Palette” on page 85

From the Files of type drop-down list, select:

• Web Images, to see a list of all image files that can be viewed in a Web 
browser, including .gif, .jpg, and .png.

• A specific file type, to see only files of that type. You can select GIF, JPEG, 
PNG, BMP, PCX, PICT, or FPX.
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• All Images, to view all files that are image files.

• All Files, to see all files in the selected folder.

3. Make sure Show thumbnail image is selected if you want to preview your image 
in the dialog.

Show 
thumbnail 
image check 
box

Thumbnail 
image

Copy to site’s Assets folder 
check box

4. Make sure Copy to site’s Assets folder is checked if you want to keep a copy of 
the original file in your Assets folder.

Note: If you plan to edit your images, it is recommended you 
save a copy to your site’s “Assets” folder. This will allow 
you to easily revert to the original image and remove all 
changes.

5. Click Open to place the image on the page.
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If you select a non-standard Web format, the Unsupported File Format dialog 
appears. 

• If you convert to .gif, NetObjects nPower reduces the image to 256 colors.

• If you convert to .jpg, NetObjects nPower retains the color information from 
the original file.

• If you choose not to convert, only browsers that have the appropriate plugin 
installed can view the image.

6. Choose the appropriate conversion format and click OK. If you chose to Copy 
to site’s “Assets” in the Picture File Open dialog, NetObjects nPower copies the 
file, converts the copy, and stores the copy in the site’s \Assets folder. Both the 
original file and the copy are listed in Assets view. Only the converted copy is 
required for your site, so you can delete the original file.

The picture and Picture Properties palette appear.

AltTag field

7. Type a description of the picture in the AltTag field.
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See “Adding and Modifying Alt Tags” on page 42.

Using the Picture Properties Palette
In NetObjects nPower, you can perform advanced image manipulation using the 
Properties Palette. If you chose to Copy to site’s Assets Folder, then when you crop 
an image, tile an image, rotate an image, or add text to a shape or picture, 
NetObjects nPower generates a new file, referred to as an auto-generated image. 
The original image is unchanged and is stored in the Assets folder.

To revert back to the original image file:

1. In Page view, click on the image you want to work with.

The Picture Properties palette appears.

2. Click on Revert to Original.

This restores only changes made to the image file, such as cropping or flipping. 
To restore the original image, add the image from the assets folder.

Warning:You cannot use Revert to Original if you did not select Save a 
Copy to site’s “Assets” folder. See See “Adding a Picture” on 
page 82.

Resizing and Orienting a Picture
Resizing a Picture
When you resize a picture and publish the site, NetObjects nPower changes height 
and width attributes of the image, so the file is displayed in the new size. 

1. In Page view, select the picture you want to resize.

The Picture Properties palette appears.

2. Click the Geometry tab.
85



Resizing and Orienting a Picture
3. To maintain the picture’s scale so that the height and width are proportional, 
select Maintain Aspect Ratio.

Select to 
maintain image 
height and 
width 
proportions

Geometry tab

4. In the Height and Width fields, select the desired image dimensions.

You can select to display the image dimensions in Pixels or Percent from the 
Unit drop-down list.

Tiling a Picture
You can create multiple instances of a picture by tiling it.

1. In Page view, select the picture you want to tile.

The Picture Properties palette appears.

2. Click the Geometry tab.

3. Select Tile.

Select to tile 
the image.

Geometry tab
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4. Drag a selection handle to enlarge the box and display more or fewer tiled 
images.

NetObjects nPower displays multiple images of the picture in the box. Each image 
is the size of the picture in the source file.

Rotating a Picture
You can rotate pictures in 90-degree increments. 

1. In Page view, select the picture you want to rotate.

The Picture Properties palette appears.

2. Click the Geometry tab.

3. In the Rotate drop-down list, select the desired rotation.

Picture rotated 90 degrees

Flipping a Picture
You can flip pictures horizontally or vertically. 

1. In Page view, select the picture you want to flip.

The Picture Properties palette appears.

2. Click the Geometry tab.

3. In the Flip field, select:

• Horizontal to flip the image horizontally along the vertical axis.
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• Vertical to flip the image vertically along the horizontal axis.

Original Image

Image flipped vertically

Image flipped horizontally

Cropping a Picture
You can crop a picture to make only part of it visible. 

1. In Page view, select the picture you want to crop.

The Picture Properties palette appears.

2. Click the Geometry tab.

3. In the Crop area, click on the crop tool icon.

The crop marquee will appear on the selected image.

Crop tool
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4. Drag any selection handle to adjust the size of the marquee enclosing the part of 
the image you want to keep. NetObjects nPower crops the portion of the picture 
outside of the marquee.

5. Click Apply in the Properties Palette to crop the image.

Adjusting a Picture’s Color
You can use the Picture properties to adjust a picture’s overall color.

1. In Page view, select the picture for which you want to adjust the color.

The Picture Properties palette appears.

Adjustment 
tab

2. Click the Adjustment tab. You will have the ability to edit images:

• Brightness to adjust the tonal range.

• Contrast to adjust overall contrasts and mixture of colors.
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• Hue to adjust the color and represents a move around the color wheel.

• Saturation to adjust the purity of the color and represents a move across the 
radius.

3. Adjust the color properties.

You can adjust a color property by dragging the slider on the properties palette, 
or by entering the width directly in the Properties Palette.

• To adjust the color property by dragging the slider on the Properties Palette, 
drag the slider to the right to increase the property, or to the left to decrease 
the property. 

• To adjust the color property by entering the value directly in the Properties 
Palette, type a number in the correct field.

As you make changes to the color, view the Spectrum bar at the bottom of the 
Properties Palette to get an idea of the color range your image will be displayed in. 
Also, as you make changes, you can preview the image.

To reset your image back to the original color, set all values to 0.

Creating a Border Around a Picture
You can use the Picture properties to add a border around a picture.

1. In Page view, select the picture for which you want to create a border.

The Picture Properties palette appears.

2. Click the Borders tab.

3. Click the Border check box to add a border around the picture.

4. Choose a border style from the Line Style drop-down list.

5. Click on the Color icon to open the Color Picker.

Select a border and click OK.
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6. In the Thickness field, specify the thickness of the border.

Borders tab

The border color is controlled by the site visitor’s browser and the page text color 
settings. Check the border appearance in the appropriate browsers before 
publishing your site.
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C H A P T E R  8
Managing Photo 
Galleries 8
If your site has a Photo Gallery, you can manage and update your digital images, 
and add captions and descriptions. Your images will look great on the Web and 
download quickly.

This chapter describes:

• Working with photos

• Adding, editing, and formatting titles and captions

• Formatting the thumbnail page
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About Photo Galleries
Each photo gallery on your site includes two types of pages—a thumbnail page and 
photo pages. 

• The thumbnail page shows a small image of each photo in the gallery. Site 
visitors click a thumbnail image to see the photo page.

Thumbnail 
image
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• Each photo page displays a large version of the image. You can add and format 
a title and caption for the photo.

Add caption text

Add title text

When you add a photo gallery object to the thumbnail page, NetObjects nPower 
automatically adds the photo page for you. On the Site Navigation palette, the 
photo page is as a single icon that contains multiple pages.

Thumbnail page 
contains the photo 
gallery object

Photo page 
contains a stack of 
pages, one for each 
photo
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Working with Photos
NetObjects nPower creates two copies of each image file in a photo gallery—one 
for the thumbnail page and one for the photo page. These copies are published 
when you publish the site; the files are generally much smaller than the original 
image file. NetObjects nPower does not change your original image file.

Adding Photos
You add photos on the Images tab of the Photo Gallery Properties Editor.

1. Open the Photo Gallery Properties Editor.

• Double-click a photo on a thumbnail page or a photo page.

The Photo Gallery Properties Editor appears, displaying the Images tab.

2. Click Add.

The Open dialog appears.

3. Navigate to the folder containing the photos you want to add to the gallery.
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4. Select the photos for the gallery. You can:

• Click a single photo to select it.

• Press Shift+Click or Ctrl+Click to select multiple photos.

• Press Ctrl+A to select all photos in the folder.

• Select “Use file name for title”

If you choose the file name for the title, it will exclude the extension and 
automatically populate the title field in the properties editor.

5. Click Add.

The photos you select are listed in the File Name column on the Images tab.
97



Working with Photos
Replacing Photos
You can easily update a photo gallery by quickly replacing images in the Photo 
Gallery Properties editor. 

1. Click the image you want to replace to open the Photo Gallery Properties 
Editor.

2. Click Modify.

3. In the Open dialog, navigate to the image you want to use.

4. Click Add to close the dialog box and update the image.

Arranging Photos
Photos are listed in the File Name column on the Images tab of the Photo Gallery 
Properties Editor in the order in which you add them to the gallery. This is also the 
order in which they appear on the photo pages. If you select several files from a 
folder, they appear in alphabetical order. This is probably not the order in which 
you want to display the photos, so you must rearrange them. 

You can rearrange the photos on the Images tab of the Photo Gallery Properties 
Editor, or directly on the thumbnail page. If you do this on the thumbnail page, you 
can see the images as you arrange them. This is useful if your photos do not have 
meaningful file names, for example 01.jpg, 02.jpg. 

Dragging Photos on the Thumbnail Page
1. Display the thumbnail page in Page view.

2. Click the image you want to move and drag it to a new position.
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A red indicator shows where the image will be placed.

Click the photo in the upper left and drag 
it to the right

When you release the mouse button, the 
photo moves into the new position

If your gallery has many photos, they will be easier to organize if you can see all 
the images in Page view without scrolling. To see as many images as possible, 
reduce the size of the thumbnail, select a template that has a thin frame (for 
example, Simple border), and increase the number of columns. When the images 
are organized as you want them, resize the thumbnails. See “Resizing Photos” on 
page 100.

Moving Photos on the Images Tab
1. In Page view, display the thumbnail page or a photo page of the gallery you 

want to work with.

2. Open the Photo Gallery Properties Editor.

3. In the File Name column:

• Select a photo and drag it into a new position in the list. 

An indicator displays as you move the photo.
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• Select a photo and click Move Up or Move Down to shift it into the proper 
position.

Resizing Photos
You can increase or decrease the size of the thumbnail images or the size of an 
individual photo page image or all the photo page images. NetObjects nPower 
retains the image’s proportions when you resize.

To resize photos:

1. In Page view, display the thumbnail page or the photo page of the gallery you 
want to work with.

2. Click an image.

The properties palette appears.

3. Resize the image.

You can change the image size by dragging the slider on the properties palette, 
by entering the width directly in the properties palette, or by dragging the 
image.
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• To change the image size by dragging, select the image and drag the small 
white box until the image is the size you want. 

Drag this box to change 
the size of the image

When you release the mouse button, the image is resized. If you are on the 
thumbnail page, all images are resized.

• To change the image size by dragging the slider on the properties palette:

Drag the slider on the properties palette to the right to increase the image 
size, or to the left to decrease the size. A dotted line rectangle increases or 
decreases proportionally as you drag and the size of the image is displayed 
in a ScreenTip.

When the image is the size you want, release the mouse button.

• To change the image size by entering the width directly in the Thumbnail 
Properties palette, type a number in the Width field. 
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Opening the Photo Gallery Properties Editor
4. Apply the change.

• If you are on the thumbnail page, click Apply to all to resize all thumbnail 
images. 

• If you are on a photo page, click Apply to resize only the current photo or 
Apply to all to resize all photos in the gallery. 

Removing Photos
You can remove photos from the gallery on the thumbnail page, on the photo page, 
or on the Images tab of the Photo Gallery Properties Editor.

Removing a Thumbnail
1. In Page view, display the thumbnail page of the gallery.

2. Select the image you want to remove and press the Delete key.

Removing a Photo Page
1. In Page view, display the photo page containing the photo you want to remove 

from the gallery.

2. Press the Delete key.

3. Click Yes to confirm deletion.

Removing Photos from the Images Tab
1. In Page view, display the thumbnail page or a photo page of the gallery you 

want to work with.

2. Open the Photo Gallery Properties Editor.

3. In the File Name column, select a photo and click Delete Item.

Click Delete All to remove all photos from the gallery.

Opening the Photo Gallery Properties 
Editor
To open the Photo Gallery Properties Editor:

• Double-click a photo on a thumbnail page or photo page.
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• Double-click a thumbnail frame.

• Click the Configure button on the Photo Properties palette on the thumbnail 
page.

• Click the Configure button on the Photo Gallery Properties palette on a photo 
page.

Adding and Editing Photo Titles and 
Captions 
A title and descriptive caption help site visitors enjoy your photos. You can add this 
text on the Images tab of the Photo Gallery Properties Editor or directly on the page 
that features the photo. If the selected thumbnail template shows the photo title, you 
can add it on the thumbnail page.

Adding and Editing Photo Titles and Captions on the 
Images Tab
1. In Page view, display the thumbnail page or a photo page of the gallery you 

want to work with.

2. Open the Photo Gallery Properties Editor.

3. Select a photo in the File Name column.

4. Click in the Title text field and type the title for the photo.

Try to make your title descriptive, but brief. 

Text you type here appears on the photo page and at the bottom of the thumbnail 
image if the selected template includes the photo title.
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5. Click in the Caption field and type text that describes the photo. If you do not 
want to add a caption, skip this step.

Text you type here appears on the photo page.

6. Click another photo in the File Name list to continue adding titles and captions, 
or click Done to close the editor.

To edit existing text, click in the text field and make changes. Be aware that if you 
formatted some or all of the text on the photo page, the formatting will be lost if 
you modify the text on the Images tab of the Photo Gallery Properties Editor.

For information about formatting the title and caption text, see “Formatting Photo 
Titles and Captions” on page 106.
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Adding and Editing Photo Titles on the Thumbnail 
Page
If the selected thumbnail template accommodates a photo title, you can enter it 
directly on the thumbnail page.

1. In Page view, display the thumbnail page of the gallery you want to work with.

2. Click in the blue border at the bottom of the thumbnail image and type the title 
text.

To edit existing text, click in the text field and make changes.

For information about formatting the title text, see “Formatting Photo Titles and 
Captions” on page 106.
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Adding and Editing Photo Titles and Captions on the 
Photo Page
1. In Page view, display the photo page you want to work with.

2. Click in the blue bordered title text field and type the title text.

3. Click in the blue bordered caption text field and type the caption text.

To edit existing text, click in the text field and make changes.

For information about formatting the title and caption text, see “Formatting Photo 
Titles and Captions.”

Formatting Photo Titles and Captions
Formatting Photo Titles
You can format all individual titles on the individual photo pages.

Formatting an Individual Photo Title
You can apply formatting to all or part of the title text. For example, you can make 
a single word bold for emphasis. Formatting you apply here is also reflected in the 
title text on the thumbnail page.
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1. In Page view, display a photo page.

 
Next

2. Click the Next button in the lower left-hand corner of the Site Navigation 
Palette until the photo you want to work on appears.

3. Select all or part of the title text.

4. Use the options on the Format tab of the Title Properties palette to format the 
text. See “Formatting Text” on page 60.

Formatting Photo Captions
You can format individual captions on the individual photo pages.

Formatting an Individual Photo Caption
You can apply formatting to all or part of the caption text. For example, you can 
make a single word bold for emphasis.

1. In Page view, display a photo page.

 
Next

2. Click the Next button in the lower left-hand corner of the Site Navigation 
Palette until the photo you want to work on appears.

3. Select all or part of the caption text.

4. Use the options on the Format tab of the Captions Properties palette to format 
the text. See “Formatting Text” on page 60.
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Formatting Photo Thumbnail Titles
If the selected thumbnail template includes a photo title, you can format individual 
titles from the thumbnail page.

Formatting All Thumbnail Titles
1. In Page view, display the thumbnail page or a photo page of the gallery you 

want to work with.

2. Open the Photo Gallery Properties Editor.

3. Display the Thumbnail Page tab.

4. Click Format Title.

5. Set the text format. See “Formatting Text” on page 60.

Formatting an Individual Thumbnail Title
You can apply formatting to all or part of the title text. For example, you can make 
a single word bold for emphasis. Formatting you apply here is also reflected in the 
title text on the photo page.

1. In Page view, display the thumbnail page you want to work with.

2. Click in a title text field.

3. Use the options on the Format tab of the Title Properties palette to format the 
text. See “Formatting Text” on page 60.

Adding Alt Tags
Adding Alt tags is an easy way to give text descriptions your photos and help 
visitors that do not have images loaded or are browsing using text-based browsers. 
Also, using Alt tags is a great way to make sure search engines recognize all 
content on your site. You can add Alt tags on both the Thumbnail Image and Photo 
Image tabs.

To add Alt tags;

1. In Page view, display the thumbnail page or a photo page of the gallery you 
want to work with.

2. Open the Photo Galley Properties Editor.
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3. Display the Images tab.

Type alt 
tag text

4. Click the Thumbnail Image tab or Photo Image tab at the bottom of the Images 
tab.

5. In the Alt tag field, type in the text you would like your site visitors to see.

Navigating Between Photo Pages
1. In Page view, display the photo page of the gallery you want to work with.

The first photo in the gallery appears.

 
Previous and Next

2. Use the Previous and Next buttons in the lower left-hand corner of the Site 
Navigation palette to move from photo to photo.

Removing a Photo Gallery
1. In Page view, display the thumbnail page of the gallery you want to remove.

2. Select the photo gallery object and delete it. 

Note: Do not delete the photo gallery unless you want to permanently 
remove it from your site. You cannot add a photo gallery to your 
site.
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C H A P T E R  9
Drawing Shapes and 
Lines 9
Shapes and lines are essential elements of Web pages. You can draw rectangles, 
rounded rectangles, ellipses, and polygons, as well as HTML horizontal rules, lines, 
or SiteStyle lines, and set shape and line properties.

This chapter describes:

• Drawing shapes and setting properties

• Drawing horizontal rules 

• Drawing and editing lines and arrows
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Drawing Shapes
To draw an ellipse, rectangle, rounded rectangle, or polygon:

 
Draw Rectangle 
tool

1. In Page view, select the Draw tool on the Standard toolbar and choose the shape 
you want to add from the flyout.

2. Draw the shape on the page.

• To draw a rectangle, ellipse, or rounded rectangle, click and draw the shape.

• To draw a polygon, click to set the start point, click to set all-but-the-last 
points, and double-click the last point.

The Properties palette for the shape you created appears.

When you draw a 
shape, the appropriate 
properties palette 
appears

3. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 42.

4. In the Line width box, set the shape outline thickness.

To make the border invisible, set it to zero.

5. In the Color section of the Properties palette, click the Fill Color button. In the 
Color Picker, select the color you want to assign to the shape fill and click OK.

6. Click the Line Color button. In the Color Picker, select the color you want to 
assign to the shape border and click OK.

7. To adjust the shape, drag its handles.
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Chapter 9 Drawing Shapes and Lines
• To change the shape proportionally, drag a corner handle while holding 
down Ctrl.

• To vary the curve of a rounded rectangle, select it, place the pointer over the 
inside corner handle until it changes to a four-headed arrow, then drag 
toward the inside or outside of the shape.

Use this handle to modify the curve

• To edit the lines of a polygon, select it, place the pointer over any handle 
until you see the four-headed arrow, then drag the handle to adjust the 
shape.

When you publish a page with shapes, NetObjects nPower generates each shape as 
a .gif file. If the page contains more than one shape of the same type, NetObjects 
nPower adds a number to the shape’s file name. For example, the first rounded 
rectangle you draw is named a_Rounded_Rectangle.gif, the second one is named 
a_Rounded_Rectangle1.gif, the third a_Rounded_Rectangle2.gif, and so on.

Adding HTML Horizontal Rules
HTML rules are always horizontal. They can display with or without beveled edges 
in a browser. When you embed an HTML rule in a text box, you can set its length 
as a percentage of the text box width.

To draw an HTML horizontal rule:

 
HR Rule tool

1. In Page view, select the Line tool on the Standard toolbar and choose the HR 
Rule tool from the flyout. 

2. Draw the horizontal rule on the page.
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The HR Rule Properties palette appears.

This option appears only when the 
rule is embedded in a text box

3. In the Thickness box, set the thickness of the rule.

The standard width is 2 pixels.

4. Select Shaded to create a bevel effect.

The standard HR rule is shaded.

5. If the HR rule is embedded in a text box, you can specify its length as a 
percentage of the text box.

Drawing Lines and Arrows

 
Line Draw tool

1. In Page view, select the Line tool from the Draw tool flyout on the Standard 
toolbar.

2. Drag from one point to another to set the position, length, and orientation of the 
line.

The point where you start dragging is the head of the line. The point where you 
finish is the tail of the line, regardless of the direction you drag. To constrain the 
line to vertical or horizontal, hold down the Shift key while dragging.
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The Line Properties palette appears.

3. Type an alt tag in the AltTag field. 

See “Adding and Modifying Alt Tags” on page 42.

4. In the Line width box, set the width of the line in pixels.

5. In the Color section, click the Color button for the line, head, and tail, choose a 
color in the Color Picker, and click OK. To set all three items to the line color, 
select All parts use one color.

6. In the Style section, select styles for the head and tail from the drop-down lists. 

If you want the head and tail to share the same style, select the style for the 
head, then select Head/Tail same style. 

Select Outline to assign the line color to the head and tail outlines, regardless of 
their fill colors.

When you publish a page with drawn lines, NetObjects nPower generates each one 
as a .gif file. On your page, each line occupies the rectangular area defined by the 
beginning and ending points of the line.

If the page contains more than one shape of the same type, NetObjects nPower adds 
a number to the shape’s file name. For example, the first line you draw is named 
a_ArrowLine.gif, the second one is named a_ArrowLine1.gif, the third 
a_ArrowLine2.gif, and so on.
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Editing Lines and Arrows
To change the length and width of a line, or to change the shape and size of the 
line’s head and tail:

1. In Page view, select the line.

Selection handles appear. 

Place the pointer over a selection handle. The pointer changes to a crosshair.

• To make the line longer or shorter, or to change its direction, drag an end 
handle.

• To make the line thicker or thinner, drag a side handle.

• To change the shape of the head or tail, drag one of its handles.

2. In the Style section of the Line Properties palette, select a style from the Head 
or Tail drop-down lists to change the head or tail style.
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C H A P T E R  10
Editing and Adding 
Tables 10
Presenting information in tabular format is often an effective way to convey 
complex concepts and ideas. NetObjects nPower makes it easy to edit tables and 
add new ones to a site. You can select and work with a whole table, just a row, just 
a column, a single cell, or several rows, columns, or cells. 

In addition, you can perform advanced actions such as sorting exporting data.

This chapter describes:

• Adding tables

• Setting table structure

• Working with cells

• Adding text and pictures to tables

• Sorting table data

• Importing table data

• Exporting table data
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Adding a Table
Adding a Table

 
Table tool

1. In Page view, choose the Table tool from the Container flyout on the Standard 
toolbar and draw a box where you want to position the table.

The Create Table dialog appears.

2. Specify the number of columns and rows in the table.

3. Set the Cell padding, which is the amount of space between the contents of a 
table cell and the cell boundaries. Cell padding is measured in pixels.

Table border

Cell spacing

Cell padding

4. Set the Cell spacing, which is the distance between cells.

5. Click OK.

Note: The properties you set when creating a new table will be 
saved and used for the next table created.

The table appears with the Table Properties palette. These properties apply to the 
entire table; you can also select a row, column, or individual cell and set its 
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properties. See “Setting Row and Column Properties” on page 125 and “Setting 
Cell Properties” on page 126.

Each table, column, row, and cell is an individual object. You can view the object 
hierarchy by choosing Object Tree from the View menu. You can also see which 
table object is selected by referring to the Object Tree palette. You can rename 
tables and cells in the Object Tree palette, but you cannot rename rows or columns.

Setting Table Properties
1. In Page view, select the table and make sure the Table tab of the Table 

Properties palette is displayed.
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2. Enter a thickness for the table border. Thickness is measured in pixels. 

Table border

Border Properties

3. In the Advanced section of the Table tab, select Generate non-breaking spaces to 
prevent empty cells from collapsing in Netscape Navigator and Microsoft 
Internet Explorer.

When this option is selected, NetObjects nPower inserts a space character in 
every table cell. If you embed an image in a table cell, the extra space causes a 
gap between the image and the cell border. To remove the gap, clear this option.

Setting the Table Background
You can have both a color and a picture in the table background. If the picture has a 
transparent area, the background color shows through.

1. In Page view, select the table.

2. Click the Background tab on the Table Properties palette and in the Color field, 
select:

• Automatic to set the table background to the color specified by its parent 
object.

• Color to select a background color from the Color Picker. The selected color 
appears in the box to the right of the Color field. To change the color, click 
the box and select a new color from the Color Picker.

3. In the Image field, select:

• Automatic to set the background to the image specified by the table’s parent 
object.
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• Browse to select an image from the Picture File Open dialog. See “Choosing 
an Image Format” on page 82. If the picture is smaller than the table, the 
browser tiles the image. If you select a picture with a transparent color, the 
background color shows through. To change the image, click the Browse 
button to the right of the field.

Adjusting the Table Structure
You can resize, add, or delete rows and columns, and merge or split cells to design 
the table structure.

Resizing Table Rows and Columns
• In Page view, select the table, and: 
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• Drag the cell guides on the vertical or horizontal ruler to resize a row or 
column. This changes the overall table height or width.

Use these handles to move the 
table

Use these handles to change 
the row height

Use these handles to change 
the column width

• Point to the border of the row or column you want to resize and drag the cell 
boundary to the new size. If you resize a row, it changes row height and the 
overall table height.

• For precise sizing of rows and columns or to make all rows or all columns 
the same size, see “Setting Row and Column Properties” on page 125.

Inserting a Row or Column
1. In Page view, select the table.

The Table Properties palette will appear.

2. Enter the total number of table rows or columns in the Rows field or Columns 
field. 

Enter number of 
rows and columns
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Additional rows are added at the bottom of the table, and additional columns are 
added at the right side of the table.

• To insert a row in a specific location, right click on the highlighted row and 
select Insert Row Above or Insert Row Below from the menu.

• To insert a column in a specific location, right click on the highlighted 
column and select Insert Column Left or Insert Column Right from the 
menu.

You can also insert rows and columns from the Cell Properties palette. See 
“Setting Row and Column Properties” on page 125

Removing a Row or Column
1. In Page view, select the table.

The Table Properties palette will appear.

2. Enter the total number of table rows or columns in the Rows field or Columns 
field. 

Extra rows are deleted from the bottom of the table, and extra columns are 
deleted from the right side of the table.

• To delete a specific row, right click on the highlighted row and select Delete 
Table Row.

• To delete a specific column, right click on the highlighted column and select 
Delete Table Column.

Merging and Splitting Table Cells
1. In Page view, select the cells in the table that you want to merge or split. See 

“Selecting Table Cells” on page 126.

The Table Properties palette will appear.

2. In the adjust area on the properties palette:

• To divide the cell, select Split Cells and enter the number of rows and/or 
columns you want to split the cell into in the Split Cells dialog. The 
maximum is 10 x 20.

• To merge cells, select Merge Cells. All borders between the selected cells 
disappear.
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Setting Row and Column Properties
When you select a table row or column, a Row or Column tab is added to the Cell 
Properties palette.

1. In Page view, select the table.

2. Select a row or column by moving the mouse pointer over the table border and 
clicking when you see the single-headed arrow. Drag to select multiple rows or 
columns.

The Cell Properties palette appears with the Row or Column tab added.

Row properties Column properties

3. Set the Vertical and Horizontal Alignment to position objects within cells.

4. Set Row height or Column width.

• Display the Row tab of the Cell Properties palette. To make all selected rows 
the same height, enter a number in the Height field, and press Enter. 

• Display the Column tab of the Cell Properties palette. To make selected 
columns the same width, enter a number in the Width field, and press Enter. 

Working with Table Cells
Each table cell is an individual object. You can add cells, set alignment of its 
content, choose a background color and picture, and format text.
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Selecting Table Cells
1. Click a cell.

2. Move the pointer over the cell and hold down the left mouse button.

3. When you see the cross-shaped pointer, drag it over the cells you want to select.

Selected cells are highlighted with a border.

Setting Cell Properties
1. In Page view, click a cell in a table to select it.

The Cell Properties palette appears.

2. If necessary, click the Cell tab.

3. Set the Vertical and Horizontal Alignment for the cell. If the cell alignment is 
set to Auto, the alignment of the row or column containing the cell is shown in 
parentheses. If you select a different setting for the individual cell, it overrides 
the row or column setting and is shown in parentheses.

• Vertical determines alignment to the top, middle, or bottom of the cell.

• Horizontal determines alignment to the left, center, or right of the cell. If the 
cell contains text, you can justify it within the cell.

4. To add cells in a table, insert new rows or columns. See “Inserting a Row or 
Column” on page 122.

5. To apply text styles and formatting to cells, click the Format tab. 

• To change the cell background color, in the Color field select:
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• Automatic to set the cell background to the color specified for the table.

• Color to select a background color for the cell from the Color Picker. The 
selected color appears in the box to the right of the Color field. To 
change the color, click the box and select a new color from the Color 
Picker.

• To change the cell background image, in the Image field, select:

• Automatic to set the background to the image used by the table.

• Browse to select an image for the cell background from the Picture File 
Open dialog. See “Choosing an Image Format” on page 82. If the picture 
is smaller than the cell, the browser tiles the image. If you select a 
picture with a transparent color, the background color shows through. To 
change the image, click the Browse button to the right of the field.

To apply text styles, see “Working with Text Styles” on page 70

6. Select Cell is a header to format the cell as a column or row heading. This 
makes it easier for people with disabilities to read the table.

Sizing Cells
To make a table cell shrink to fit the content in the cell:
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Sorting Table Data
1. Right-click in the cell you want to size.

2. Select Fit Cells from the shortcut menu.

The cell shrinks to fit the content.

Adding Text and Pictures to Cells
Working in a table cell is the same as working in a text box. You can:

• Add and format text. You can apply formats to all selected cells at one time. See 
“Formatting Text” on page 60

• Embed objects. See “Embedding Objects in a Text Box” on page 51.

• Wrap text around objects. See “Wrapping Text around Objects” on page 53.

• Modify text box properties. See Chapter 5, “Working with Text Boxes.”

To select the contents of a cell:

• Double-click the cell.

Cross-hatching appears around the selected cell. You can edit the text in the cell 
or change cell properties.

Sorting Table Data
You can sort the table data by column in ascending or descending order.

1. In Page view, select the table you want to work with.

2. Right click and select Sort Table from the menu.

The Sort Table dialog will appear.

3. In the Sort by section, select the columns you want to sort. You can sort by:
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• Ascending Order (A to Z)

• Descending Order (Z to A)

• Ascending Numeric Order (1, 2, 3, 4, 5 . . .)

• Descending Numeric Order (5, 4, 3, 2, 1 . . .)

4. In the Options area, select:

• Exclude Cell headers to exclude cells marked as headers from the sort.

Note: If you select to Exclude Cell Headers, the cell headers will 
appear in the Sort By fields.

• Ignore initial white space to sort the cell data by the first character that is not 
a space.

• Sort selected cells only to sort the selected rows only.

Importing Table Data
You can import existing table data or display data from a file using the Table Import 
tool.

1. In Page view, choose the Table Import tool from the Container flyout on the 
Standard toolbar and draw a box where you want to position the table.

Table Import Tool
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Exporting Table Data
The Import Table dialog appears.

2. Browse to the location the file that has the table data you want to import.

3. In the Delimiter drop-down list, choose:

• Tab to import a tab-delimited (.txt) file.

• Comma to import a comma-delimited (.csv) file.

• Custom to specify a new delimiter. Type the custom delimiter in the field 
next to the Delimiter drop-down. This field is only available if using a 
custom delimiter.

Note: Only single-character delimited files can be imported. For 
example, files using the delimiter “/” are acceptable, while 
files using “//” are not.

4. Complete the Table Properties section. See “Setting Table Properties” on 
page 119.

Exporting Table Data
You can export table data as tab delimited (.txt) and comma separated (.csv) files.

1. In Page view, select the table you want to work with.

2. Right click and select Export Table from the menu.

The Export Table dialog appears.

3. Choose a location to save the file to.
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4. Type a file name to save the data as.

5. In the Save as Type drop-down, select:

• Text (Tab Delimited) to save as a .txt file

• CSV (Comma Delimited) to save as a .csv file.

6. Click Save.

The file will be saved to the location specified.
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C H A P T E R  11
Creating Links and 
Anchors 11
NetObjects nPower makes it easy to create navigation aids using links. You can 
make any text, image, shape, or area of an image into a navigation aid by adding a 
link. Link page objects to any point on the Web, including points within your site, 
or open your link in a pop-up window.

This chapter tells you how to create and use:

• Internal links

• Anchors

• Smart links

• External links

• Email links

• Relative links

• File links

• Link targets

• Imagemaps
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Creating Links
You can use the linking techniques described in this chapter to manually link 
objects such as text, pictures, and drawn shapes to internal locations in a site and 
external locations such as files and other Web pages. As you edit your site and 
create new content site, you’re likely to create multiple links to the same location.

You can use the Link button on the Properties palette or click the Link tool on the 
Standard toolbar to open the Link dialog, where you specify the destination of a 
link. 

Types of Links
There are four types of links, each with its own options in the Link dialog:

• Internal link, which links to a page or anchor within the site.

• Smart link, which links to a relative position in the site, such as previous page or 
next page. Smart links are sometimes called structural links. The Blank link, 
which you can use to trigger an action without going to a new page, is also a 
smart link.

• External link, which links to a page in another site via a URL, using a protocol 
such as ftp, mailto, http, or JavaScript.

• File link, which links to a file that visitors can download from the site. 

Link Indicators
You can link a selected object or text, or a text insertion point.

 
Link icon

• If you Link an object, the Link icon indicates the object is linked.

• If you select text and link it, the selected text is underlined and appears in the 
default font and color for links. 

• If you place an insertion point in text without selecting text, the link name is 
inserted in the text.

Creating an Internal Link
Internal links link to pages or anchors within a site. If you move a linked page in the 
Site Editor or change the page’s name, NetObjects nPower automatically updates 
all associated links.
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Chapter 11 Creating Links and Anchors
Using an anchor, you can link to a specific page or to a specific location on the 
current page. See “Adding, Editing, and Deleting an Anchor” on page 137. 

To create an internal link:

1. In Page view, select an object or text to link. 

If you place an insertion point in text without selecting text, the link name is 
inserted in the text.

 
Link tool

2. Click the Link tool on the Standard toolbar or the Link button on the object’s 
Properties palette.

The Link dialog appears. 

3. Select Internal Link as the link type.

List of all pages in the 
site

See “Setting Link 
Targets” on page 145

Anchors 
on the 
selected 
page
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• If you are linking to a page, select the page in the SiteStructure.

• If you are linking to an anchor on a specific page, select the page in the 
SiteStructure and then select the anchor from the list on the right.

4. To set a link target, see “Setting Link Targets” on page 145.
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Note: You may not need to select a frame target. NetObjects 
nPower automatically targets most internal links. If you 
select <none>, NetObjects nPower uses the default target.

The destination page for the link appears only in the frame you select.

5. Click Link.

NetObjects nPower creates the link. When a site visitor clicks the linked item, the 
browser displays the destination page or the selected anchor.

Adding, Editing, and Deleting an Anchor
An anchor marks a specific location on a page. Anchors let site visitors go directly 
to a particular part of a long page instead of scrolling and searching for information. 
You can place an anchor anywhere in a text box or table, or on a picture or drawn 
shape. You link to an anchor using the Link dialog. When a site visitor clicks the 
link, the browser displays the page containing the anchor, beginning at the location 
of the anchor.

When an anchor link is in a MasterBorder, use the Current page option in the Link 
dialog to ensure that the link always points to an anchor on the current page. If you 
want an anchor link to always lead to a specific page, select the page name instead 
of the Current page option when you link to the anchor.

For example, suppose your Layout contains a very long text box. You place 
anchors at the top and bottom of the text box, and in the MasterBorder, you link the 
words To Top to the top anchor and the words To Bottom to the bottom anchor. In 
the Link dialog, instead of choosing the current page name in the Page name 
section, you choose the Current page option. If you copy that text box to another 
page with the same MasterBorder and replace its content, the To Top and To 
Bottom links still work, jumping to locations on the current page instead of the 
page where you made the links.

To add an anchor:

1. In Page view, select an image or drawn shape or double-click to place the 
insertion point within a line of text.

If you place the insertion point within the text without selecting any text, the 
anchor is placed at the location of the insertion point. If you select text, the 
anchor is placed at the beginning of the selected text.
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Anchor tool

2. On the Standard toolbar, click the Anchor tool.

The Add Anchor dialog appears listing anchors already on the page. 

3. Type a name for the anchor in the Name field. The name cannot contain spaces. 
Make sure each anchor has a different name.

4. Click OK.

 
Anchor icon

If Object Icons is checked on the View menu, the Anchor indicator appears at the 
anchor location on the page.

To edit the anchor, select the anchored text or object, click the Anchor button on the 
Properties palette, and change its name in the Change Anchor dialog. To delete the 
anchor, click the Anchor icon and click Remove in the Change Anchor dialog. If 
you are working with a text object, you can click the anchor icon to open the 
Change Anchor dialog.

Creating a Smart Link
Smart links lead to a page in your site based on its relative position in the 
SiteStructure, rather than its name. These links automatically adjust when you 
change the SiteStructure. For example, if your smart link leads to the parent of the 
current page, and you move the current page to a different parent, NetObjects 
nPower updates the link to point to the new parent. Sometimes a smart link is called 
a structural link.

To create a smart link:

1. In Page view, select some text or select an object to link.

If you link to a text insertion point, the link name is inserted in the text.
138



Chapter 11 Creating Links and Anchors
2. On the Standard toolbar, click the Link tool.

The Link dialog appears.

3. Select the Smart Link type.

See “Setting Link 
Targets” on page 145

4. Select the type of link you want. The links listed depend on the type of page you 
are on—normal or stacked, and on what pages are available to link to from the 
page you are on.

• Home links to your Home page.

• Up links to the parent of the current page.

• Next Stacked Page links to the next page in a set of stacked pages.

• Previous Stacked Page links to the previous page in a set of stacked pages.

• Next Page links to the sibling to the right of this page in the SiteStructure.

• Previous Page links to the sibling to the left of the current page in the 
SiteStructure.

• First Child Page links to the first child page of the current page.

• Blank creates an empty JavaScript link on the page that you can use to assign 
an action. 

5. Click Link.
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Creating an External Link
External links are Universal Resource Locators (URLs) that point to other pages 
and items in other sites. A valid URL can include the protocol, host name or DNS, 
path name, and sometimes a file name, such as http://www.netobjects.com/products/
npower.html.

To create an external link:

1. In Page view, select some text or select an object to link.

2. On the Standard toolbar, click the Link tool.

The Link dialog appears.

3. Select the External Link type.

New link list with 
protocol selected

URL 
entry 

Name of link

List of previously 
entered links

See “Setting Link 
Targets” on page 145

4. Select a protocol from the New link drop-down list.

If you’re creating a link that does not require a protocol, select (none). If you 
want to use a protocol that is not in the drop-down list, you can type it in.

5. Enter the appropriate information in the URL entry field and click Save, or 
select an existing link from the list. For example, you could enter a URL, a 
mailto address, or a Java command depending on the selected protocol. For 
details about email links, see “Adding an Email Link.”
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6. If you’re creating a new external link, you can edit the default name for this link 
in the Name column by double-clicking in the column field and typing.

7. Click Link.

Note: You can also create an external link as you type. If your text 
includes @ or ://, NetObjects nPower automatically creates an 
external link.

Adding an Email Link
To add a mailto link:

1. In Page view, select some text or select an object to link.

If you place the insertion point in text without selecting text, the email address 
is inserted in the text as the link.

2. On the Standard toolbar, click the Link tool.

The Link dialog appears.

3. Select the External Link type.

4. Select mailto from the New link drop-down list.

5. In the text entry field, type the email address using the format 
username@domain.com.

6. Click Link.

7. Preview the page.

When you click the link, the browser’s email client displays a mail window 
with the address you entered in the recipient field, provided the browser is 
configured to send email using the HTML mailto command.
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Adding a Relative Link
Relative links are important if you must link to files that are published separately. 

To create a relative link:

1. In Page view, select some text or select an object to link.

2. On the Standard toolbar, click the Link tool.

The Link dialog appears.

3. Select the External Link type.

4. Select (none) from the New link drop-down list.

5. In the text entry field, type the relative path. For example:

../Articles/PressRelease1.html

You cannot test this link by previewing, because it requires the exact 
configuration of files that only exists on the server. However, after you publish 
the site and the articles are uploaded into the Articles directory, the link will 
work correctly.

When typing the path, if you do not include periods or slashes in front of the file 
name, NetObjects nPower attempts to find the file in the same directory as the 
page containing the link. This is also true for the format ./filename.html. To back 
up one directory before looking for the path, use ../path/filename.html. For each 
directory you need to back up to find the destination file, include another ../. For 
example, suppose you create a Press Releases page in a directory called PR 
within the News directory:

index.html 
/News 
   news.html 
   /PR

      PRlinks.html 
/Articles 
   PressRelease1.html 
   PressRelease2.html

A link from PRlinks.html to PressRelease1.html looks like this:

../../Articles/PressRelease1.html
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Remember that some servers are case sensitive; your link must exactly match 
the directory names and file names of where you want to go.

6. Click Link.

Creating a File Link
You use file links to link to a file. For example, you might create a file link so site 
visitors can download the file. When you create a file link, the file it refers to 
becomes an asset of the site and is uploaded to the server when the site is published. 

To create a file link:

1. In Page view, select some text or select an object to link.

If you place the insertion point within the text without selecting text, the file 
name is inserted in the text.

2. On the Standard toolbar, click the Link tool.

The Link dialog appears.

3. Select the File Link type.

Location 
of file

List of file links 
previously entered

Converts linked file 
to HTML

See “Setting Link 
Targets” on page 145

The File path field displays the path to the file and the Name column displays 
the name that appears as the link if no text or object is selected.

4. Click Browse, select a file in the Open dialog, and click Save.
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5. If necessary, enter or edit the Name.

6. Select Convert to HTML document when publishing so all site visitors can view 
the document. If your linked file remains in its original format, it can only be 
opened by applications that support that file type. This feature only works with 
.doc, .mcw, .xls, and .rtf files.

7. Click Link.

Note: The way the linked file opens for site visitors depends on the 
configuration of their browser and Web server. Test the link in the 
appropriate browsers before publishing the site.
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Setting Link Targets
NetObjects nPower allows users to open link targets in existing frames and pop-up 
windows.

Setting Frame Targets
When a site visitor clicks a link placed within a frame, the browser has to know 
where to display the results. The frame that displays the retrieved content is the 
target of the link; when you specify which frame is to display the results of a link, 
you are targeting that frame. NetObjects nPower includes four default targets. 
Choose:

• _blank to load the specified link into a new browser window.

• _self to replace the frame where the link resides with the document of that link. 
This is similar to how links behave on sites with no frames.

• _parent to load the designated content into the current window’s parent. If the 
current frame has no parent the content is loaded into the same frame as the 
element that refers to this target.

• _top to load the designated content into the full, original window. This cancels 
all other frames. If the current frame has no parent, the content is loaded into the 
same frame as the element that refers to this target.

To display the designated content in a new named window, you can create a new 
link target.

To set a link target:

1. In Page view, select the object or text that you want to link.

2. Click the Link tool on the Standard toolbar.

The Link dialog appears.

3. Select the type of link you are targeting: Internal Link, Smart Link, External 
Link, or File Link and set up the link. See “Creating Links” on page 134.

4. In the Target area, choose Existing target from the drop-down list.
145



Setting Link Targets
5. In the Name area, choose a default target from the drop-down list.

To display the designated content in a new named window, click Add and type 
a name for the window in the Custom Target dialog box. If a window with that 
name already exists, the content is displayed in the existing window.

You may not need to assign a target. NetObjects nPower automatically targets 
most internal links for you.

6. Click Link to close the dialog and create the link.

7. Preview the page to test your targeted links.

Setting Pop-Up Window Targets
To display the designated content in a new pop-up window, you can create a new 
link target.

To create pop-up windows:

1. In Page view, select the object or text that you want to link.

2. Click the Link tool on the Standard toolbar.

The Link dialog appears.

3. Select the type of link you are targeting: Internal Link, Smart Link, External 
Link, or File Link, and set up the link. See “Creating Links” on page 134.

4. In the Target area, choose Pop-Up Window from the drop-down list.

To display the designated content in a new pop-up window, click Add. The 
Pop-Up Windows Properties Editor will appear.

5. In the Name field, type in a name for the new pop-up window.
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If a pop-up window with that name already exists, the content is displayed in 
the existing pop-up window.

6. To set the size of the pop-up window on the screen, enter values for the height 
and width, in pixels. 

Select Full Screen to have the pop-up window fill the entire screen.

7. To set the position of the pop-up window on the screen, enter values for the left 
and top positions, in pixels. Placement will be offset from the upper left corner 
of the screen.

Select Auto Center to automatically center the pop-up window in the middle of 
the screen.

8. Customize your pop-up window by selecting from the following options:

• Show Toolbar to add a navigation toolbar to the browser.

• Show Scroll Bar to scroll left-right and up-down in the browser.

• Show Menu Bar to add the browser’s menu bar. 

• Show Status Bar to display the page status in the browser.

• Resizable to provide the ability to resize the pop-up window.

9. Click Preview & Set to preview the pop-up window in a browser.
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To adjust the pop-up window settings, resize and reposition the browser 
preview window, then click Set. The new settings will take effect.

10. Click OK to close the Pop-Up Window Properties Editor.

11. Click Link to close the dialog and create the link.

12. Preview the page to test your targeted links.

Following Links

 
Link icon

If Object Icons is checked on the View menu, NetObjects nPower displays the Link 
icon wherever you create a link to an object. If you place the pointer over the icon, 
the link is displayed in the status bar at the bottom of the NetObjects nPower 
window. 

Text links are underlined and appear in the default font and color for links. 

In Page view, you can follow a link you created to its target page or anchor:

• Right-click a linked object and select Follow Link from the shortcut menu.

• To follow a text link, select the linked text, right-click, and select Follow Link 
from the shortcut menu.

Finding a Link
As the number of pages in your site grows, the number of links will probably 
increase as well. NetObjects nPower makes it easy for you to find a link.

1. Open the Link dialog.

2. Click the Find button.
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The Find link type Link dialog appears.

3. Select criteria for the search, enter the text you want to search for, and click 
Find. 

NetObjects nPower finds the first link that satisfies your criteria.

4. To find the next link that matches the criteria, click Find Again.

Editing or Removing a Link
To edit a link, select the linked text or object, click the Link button on the 
Properties palette or Standard toolbar, then change the link in the Link dialog.

To remove a link, select it, click Link on the Properties palette or Standard toolbar, 
and click Unlink in the Link dialog.

Working with Imagemaps
An imagemap is a picture that contains several links. Each link is assigned to a 
particular section of the picture. You create an imagemap by drawing hotspots on a 
picture. You can link as many hotspots as you like in a single image, but the 
hotspots cannot overlap or extend beyond the edge of the picture.

To create a single link on a picture, you do not need to use an imagemap unless you 
only want to link part of the image. Imagemaps are only necessary to create 
multiple links on one object.

Creating an Imagemap

 
Hotspot tool

1. In Page view, click the Hotspot tool on the Standard toolbar, and select the 
appropriate tool from the flyout to create a rectangular, circular, or polygon 
hotspot.

2. Draw a hotspot on an image.

If you are using the Polygon Hotspot tool, you must click to establish each 
vertex of the polygon, then double-click to complete the hotspot shape.
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The Link dialog appears.

3. In the Link dialog, select a link type—internal, smart, external, or file. 

See “Creating Links” on page 134.

4. Select a destination for the link and click the Link button.

Once a picture has hotspots, you can move it anywhere on the page and even copy 
and paste it elsewhere in the site without affecting the imagemap.

Editing an Imagemap
To edit an existing hotspot, click the hotspot. The General tab of the Hotspot 
Properties palette appears.

• To edit the link, click Link on the Properties palette or the Standard toolbar. The 
Link dialog appears, displaying the link information. Change the link 
destination or click Unlink to remove the link.

• To resize a hotspot, select it and drag its handles.

• To create an alt tag for the hotspot, type in the AltTag field. The alt tag appears 
when the browser does not display the image.

• To create multiple hotspots on an imagemap, create one hotspot, copy it, and 
paste it on the image. The pasted hotspot appears in the upper-left corner of the 
imagemap. Move the hotspot to the appropriate location and edit the link.
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Adding Layouts 12
Layouts are containers for the objects you place on your pages. When you use 
Layouts, you can position content with pixel-level precision by dragging it into 
place in the container.

This chapter describes:

• Working with Layouts

• Creating Layouts
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Working with Layouts
The Layout makes up the body of the page. It is surrounded on all four sides by the 
MasterBorder. Each Layout is attached to a single page, unlike a MasterBorder, 
which may be applied to many pages in the site. There is no connection between 
Layouts on separate pages.

Each page has a default Layout named PagenameLayout. For example, when you 
add a page, its page name is Untitled#. Until you rename that page, the default 
Layout is named Untitled#Layout.

You can add multiple Layouts to a page, each with its own properties, design, and 
content. You might use several Layouts to prototype or publish several versions of 
the same page. When you publish the site, NetObjects nPower publishes each page 
using the currently selected Layout.

The name of the currently selected Layout appears in the Layout drop-down list in 
the lower-left corner of Page view.

Layout drop-down list

Current Layout

You can control various characteristics of the Layout’s appearance in Page view. 
See “Setting Up the Page View Display” on page 35.

You cannot delete a Layout. Objects in any Layout you create are always treated as 
in use, even if the Layout is not selected.

Creating a New Layout
1. In Page view, display the page for which you want to create a new Layout.

2. Select Add from the Layout drop-down list.

A new, blank Layout appears. Any content on the previous Layout is stored 
with that Layout. Each Layout you add is named PagenameLayout#. The 
number is incremented for each Layout you create for the page. To change the 
Layout name, see “Renaming a Layout” on page 153.
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3. Add objects to the Layout and modify the Layout properties—such as size or 
background.

Selecting a Layout
To display a different Layout for a page:

• In Page view, select a Layout from the Layout drop-down list.

Renaming a Layout
1. In Page view, select a Layout from the Layout drop-down list.

The General tab of the Layout Properties palette appears.

2. Enter a new name in the Layout name field.

Use letters and numbers only; Layout names cannot have spaces, hyphens, 
underscores, or other special characters, and they cannot begin with a number.

The name of the Layout changes and the Layout drop-down list is updated.

You can also use the Object Tree palette to change the name of the Layout. See 
“Renaming an Object” on page 44.
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Changing Layout Size
You can set Layout size by entering specific measurements on the Layout 
Properties palette or by dragging the Layout handles.

Adding an Object to the Layout
The Layout is the default container for the page, and can contain any object. To 
place objects in a Layout, you can:

• Select the appropriate tool and create an object within the Layout.
• Paste an object into the Layout from the Clipboard.
• Drag and drop any object that you previously placed with a tool.
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Modifying 
MasterBorders 13
NetObjects nPower divides a page into the Layout area and the MasterBorder area. 
You can place anything in a MasterBorder that you can place in the Layout, 
including pictures and text.

When you modify a MasterBorder, NetObjects nPower automatically makes the 
change on every page that shares the MasterBorder.

This chapter describes:

• Working with MasterBorders

• Resizing a MasterBorder

Note: You cannot modify the MasterBorder if it has been protected. A 
protected MasterBorder is indicated by a padlock icon in the 
upper left-hand corner of the MasterBorder.
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Working with MasterBorders
The MasterBorder is the set of margins—top, bottom, left, and right—on the page.

Top margin

Left margin

Right margin

Bottom margin

By default, the left, right, and bottom margins are separated from each other by an 
outline. The lack of an outline between the left margin and the top margin indicates 
objects can straddle that boundary.

All pages have a MasterBorder. If no MasterBorder is visible, either the 
MasterBorder display is turned off on the View menu, or the assigned 
MasterBorder has all margins set to zero. You can change the size of any 
MasterBorder margin, even those set to zero, as long as the MasterBorder is not 
locked.
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Selecting a MasterBorder
• In Page view, click an empty space inside the MasterBorder. If the 

MasterBorder margins are set to zero, click in the gray area outside the page.

This page has a visible MasterBorder. 
Click inside it.

This page has MasterBorder margins set at 
zero. Click outside the page.

Resizing the MasterBorder
1. In Page view, select the MasterBorder.

2. To change the size of the margins, drag the handles on the ruler.

Drag these handles to 
change the 
MasterBorder size

If an object is in the way—such as a banner occupying the top and left margin—
you must move the object to resize the MasterBorder. If the MasterBorder is not 
visible, you cannot drag the handles.
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3. Arrange objects such as a banner or navigation buttons, delete unwanted 
objects, and insert additional text or objects.

MasterBorder margins before and after being resized
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Modifying Navigation 
Bars and Banners 14
You can customize the your site’s banners and buttons by assigning other styles or 
labels or by replacing their images with your own.

This chapter tells you how to use navigation bars and banners, including:

• Setting navigation structure

• Setting navigation bar properties

• Customizing banners and navigation bars
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Working with Banners and Navigation 
Bars

Button navigation bar

Text navigation bar

Banner

Button 

You can change Banner titles and button names using the Custom Names command 
on the Edit menu or the settings on the Navigation Button or Banner Properties 
palette in Page view. Buttons are linked according to your site’s structure. 
Whenever you change the SiteStructure, NetObjects nPower updates the buttons 
and banners.

When you preview or publish your site, NetObjects nPower creates a .gif file for 
each button and banner.

Using Navigation Bars
Navigation bars are rows or columns of buttons or text that are automatically linked 
to other pages in your site. With NetObjects nPower, you can choose from either 
button navigation bars or text navigation bars.
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Setting Navigation Structure
You set the navigation structure to specify the relationship between the current 
page and the pages linked to the buttons on the navigation bar. You can base 
navigation structure on the site structure or create custom navigation bars to give 
visitors access to pages on different levels of the site, pages in other sites, and files.

Creating Navigation Bars Based on the SiteStructure
You can choose a navigation level and then set the multi level options to add links 
to other pages in the site. Open the Site Navigation palette if you are unsure about 
the site levels you want to link.

1. In Page view, select the navigation bar.

The General tab of the Navigation Bar Properties palette appears.

2. In the Navigation structure section, choose a level from the drop-down list.

• First Level links to the children of the Home page.

• Parent Level links to pages in the level above the current page in the 
SiteStructure.

• Current Level links to the current page and all other pages that share the same 
parent page.

• Child Level links to the children of the current page.

• Breadcrumb Trail displays the current page as the last level of a navigation 
tree and each parent page in succession.

3. In the Include section, select:

• Include home page to add a Home page link to the navigation bar. 

• Include parent page to include a link to the parent page in the navigation bar.
161



Using Navigation Bars
• Include child pages to include links to the child pages in the navigation bar.

Style tab

Set Button Background
You can set a background color for a button navigation bar. A background color 
can visually unify a navigation bar if buttons are widely spaced; it can also help site 
visitors distinguish the navigation bar from the background of the page.

1. In Page view, select the navigation bar.

2. Click the Style tab of the Navigation Bar Properties palette.

3. In the Background color section, click the Color button and select a color from 
the Color Picker or select None to use no background color.

Setting Navigation Bar Orientation
1. In Page view, select the navigation bar.

2. In the Options section, select Vertical or Horizontal orientation.

Set Border Width and Button Spacing
You can set the thickness of a button navigation bar’s border, as well as the spacing 
between buttons. You can increase the spacing between buttons to let the 
background show through or to add visual breaks around buttons. The border and 
spacing are measured in pixels regardless of the measurement unit you select in the 
Options dialog. You cannot change the spacing or border for text navigation bars.

To set button border and spacing:
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1. In Page view, select the navigation bar.

The Navigation Bar Properties palette appears.

2. Click the Style tab of the Navigation Bar Properties palette.

3. In the Display (in pixels) section:

• To change the thickness of the navigation bar border, enter a number in the 
Border field or click the arrows.

• To change the spacing between buttons, enter a number in the Spacing field 
or click the arrows.

Creating a Custom Navigation Bar
To create a custom navigation bar, you first create a separate site structure that is 
used only with the navigation bar. You set up a page structure in the same way you 
would in the Site Editor. In the navigation structure, however, you can have 
multiple pages at the same level as your Home page, plus add the same page to 
different trees. This is especially helpful if you are designing sites, such as 
intranets, in which you want to break your design into “mini” sites.

To create a custom navigation bar structure:

1. In Page view, select the navigation bar.

2. In the Structure section, select Custom and click Edit Custom.
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The Custom Navigation Bar dialog appears. 

3. From the Link type drop-down list, select:

• Internal Link to link to another page in the site.

Select a page in the list on the left and click Add to move it into the list on 
the right, or drag it from the left to the right.

• External Link to link to a page in another site. Type the path to the page you 
want to link to; for example, http://www.netobjects.com and click Add to 
move it into the list, or drag it from the left to the right.

• File Link to link to a file. Type the path to the file you want to link to or click 
Browse to locate the file, click Save, and then click Add to move it into the 
list or drag it from the left to the right. 

If your site has many pages and a lot of links, click Find to search for a specific 
link in the list of current links. Click Find Again to search for the next 
occurrence of the same link.

4. To arrange the order of pages on the navigation bar, simply drag the pages into 
position.

To remove a page, select it and click Remove. To clear the structure and start over, 
click Remove All.
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Setting Button Navigation Bar Properties

Set Button Style
New navigation bars use the currently applied SiteStyle, but you can set individual 
navigation bars to use any available button sets associated with any available 
SiteStyle.

Primary and secondary navigation bars offer different sets of button pictures, which 
are defined by the current SiteStyle. Other than the pictures displayed, primary and 
secondary navigation bars function the same way. Because secondary button 
pictures are typically different in size, shape, or color, you can use a secondary 
navigation bar to visually distinguish links to different parts of your site. For 
example, to help site visitors understand the SiteStructure, you can use the 
secondary navigation bar for the lower levels of your site.

You can also choose whether the button for the current page will be highlighted or 
not. Use button highlighting to show site visitors which page they are on.

A highlighted 
button indicates 
the current page

You can also enable rollover buttons on the navigation bar. If rollover is on, when a 
site visitor moves the pointer over the button, the SiteStyle rollover image appears.

To set the button style:

1. In Page view, select the navigation bar.

2. Click the Style tab of the Navigation Bar Properties palette.

Style tab
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3. In the Button style section:

• Select the page level, which is relative to the current page, you want to apply 
the button style to. The style you choose will apply only to the pages at the 
selected level.

The current page is Level 0, its parent page is Level -1, the next parent page 
is Level -2, and so on, until you reach the Home page.

The current pages child is Level +1, its child is Level +2, and so on.

Level -2

Level -1

Level 0 (Current 
Page Level)

Level +1

.

• Choose the SiteStyle from the drop-down list that contains the button style 
you want to display.

Only active site styles will appear in the list.

• Choose the set from the drop-down list that contains the button style you 
want to display.

4. Click Apply to all to apply the selected style to all buttons in the navigation bar.

5. In the Include section, select:

• Use highlighted buttons to use the Highlighted button state style for the selected 
page in the navigation bar.

• Use rollover buttons to use the Rollover button state for the selected page in the 
navigation bar.

• Fly-out submenus to make child pages not included in the navigation bar 
visible when the site visitor moves the pointer over the parent page link.
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• Auto-close fly-out submenus close the fly-out submenus when the mouse is no 
longer hovering over.

Use fly-out submenus to make child 
pages not included in the navigation bar 
visible when the site visitor moves the 
pointer over the parent page link

Creating a Custom Navigation Bar Style
New navigation bars use the current SiteStyle, but you can apply button sets 
associated with any available SiteStyle to a page.

In addition, you can apply advanced settings, such as how the fly-out submenus are 
displayed on the page, to a custom navigation bar. If you change the style of a 
navigation bar in a MasterBorder, it changes on every page using that 
MasterBorder. 

To create a custom navigation bar:

1. In Page view, select the navigation bar.

2. Click the Style tab of the Navigation Bar Properties palette.

3. In the Style section, select Custom and click Edit.

The Custom Style dialog appears. 

4. Select a page level from the site structure list on the left that you want to 
customize.

5. Select the Site Style and Button set you want to use for the page level selected 
in Step 4.
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Only active styles will appear in the Site Style drop-down list.

6. Select Include Fly-out submenus to make child pages not included in the navigation 
bar visible when the site visitor moves the pointer over the parent page link.

The advanced Fly-out submenu settings will become active.

• Orientation displays the fly-out submenu horizontally or vertically.

• Open describes how the menu will unfold.

• Offset defines the position of the fly-out submenu.

7. Click Apply to save the current page level settings.

8. Repeat steps to apply custom styles to additional page levels or click OK to 
close the Custom Style dialog.

Change a Button’s Name
To change the text on a button:

1. In Page view, navigate to the page containing the navigation button you want to 
change.

2. Double-click the button to select it.
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A wide border surrounds the button to show it is selected.

The General tab of the Navigation Button Properties palette appears.

3. Clear the Use page name in button check box.

4. In the Button title field, type a new name for the button. To enter two lines of 
text, press Enter at the end of the first line.

This changes the button name only in the selected navigation bar. To change the 
name of all instances of this button on all navigation bars, change the Page name 
field or use the Custom Names dialog. See “Using Custom Button and Banner 
Names” on page 26.

To restore the default page name, select Use page name in button.

Change a Button’s Image
You can change the picture on each individual button in a navigation bar in Page 
view. When you assign a new picture to a button, NetObjects nPower does not 
display the page name or custom name on the button. If you want text to appear on 
the button, you must include the text in your button picture. You do not change the 
current SiteStyle when you customize a button picture.

To change the picture for one button:
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1. In Page view, navigate to the page containing the navigation button you want to 
change.

2. Double-click the button to select it.

A wide border surrounds the button to show it is selected.

The General tab of the Navigation Button Properties palette appears.

Click Browse to change the button image or rollover image and select an image file 
from your hard disk or LAN. If you want to use an image that is on a CD-ROM, 
copy it to your hard disk first.

Setting Text Navigation Bar Properties
1. In Page view, select a text navigation bar.

The Navigation Bar Properties palette will appear.

2. In the Background Color field, select:

• Automatic to set the background to the site’s specified Text NavBar color.

• Transparent to set the background to the background color specified by the 
parent object of the text navigation bar.

• Color to select a background color from the Color Picker. The selected color 
appears in the box to the right of the Color field. To change the color, click 
the box and select a new color from the Color Picker.

3. In the Image field, select:
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• Automatic to set the background to the image to the site’s specified Text 
NavBar style.

• None to eliminate the background image.

• Browse to select an image from the Open dialog. See “Choosing an Image 
Format” on page 82. If the picture is smaller than the navigation bar, the 
browser tiles the image. To change the image, click the Browse button to the 
right of the field.

4. In the Delimiters section, select the characters you want to use before and after 
each link in a text navigation bar.

The default characters are square [brackets]. You can choose angle brackets, or 
other characters, or leave this blank.

Select Include delimiters in link to extend the underline to include these 
characters.

Linked page Current page

Delimiter

5. If you are working with a horizontal text navigation bar, in the Format section, 
you can select Right, Left, or Center alignment.

If you select Constrain to a single line, NetObjects nPower increases the page 
width to accommodate the navigation bar on a single line. If you clear this 
option, you can reduce the width of the navigation bar so it appears on more 
than one line.

6. By default all pages in a text navigation bar are linked except the current page. 
Select Link current page in the Options section to include a link to the current 
page.

Text navigation bars use the SiteStyle’s linked text color and the style set for the 
TextNavBar object.
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Setting a Navigation Bar Target
When a site visitor clicks a navigation bar link, you can target a frame or a pop-up 
window to display the linked page. For example, if you select _blank as the link 
target, the page you link to appears in a new browser window.

1. In Page view, select a navigation bar.

2. Click the General tab of the Navigation Bar Properties palette.

3. In the Navigation bar target section, select a target from the drop-down list or 
click New Target and add a target.

For more information on link targets, see “Setting Link Targets” on page 145.

Using Banners
Banners are picture title bars that display the name of the page, helping site visitors 
understand where they are in your site.

Set the banner name 
on the Banner 
Properties palette
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Changing the Banner Text
You can specify a custom name or no name for the banner. You can also split 
banner text into two lines. The style of the banner text is determined by the current 
SiteStyle.

To change the banner text:

1. In Page view, select the banner.

The General tab of the Banner Properties palette appears.

2. Clear the Use for Banner title check box.

3. In the Banner title field, type the new text for the banner. To make the text two 
lines, press Enter at the end of the first line.

To restore the default page name, select Use for Banner title.

This changes the name only on the selected banner. To change the name on all 
banners on this page, type a new name in the Page name field or use the Custom 
Names dialog. See “Using Custom Button and Banner Names” on page 26.

Setting Banner Style and Orientation
New banners use the current SiteStyle, but you can apply banners associated with 
any available SiteStyle to a page. If you change the style of a banner in a 
MasterBorder, it changes on every page using that MasterBorder.

1. In Page view, select the banner.

The General tab of the Banner Properties palette appears.

2. In the Site Style field, select the style that contains the banner you want to 
display. 

Only available styles will appear in the list.

3. In the banner field, select the banner you want to display. 

4. In the Display section, select Horizontal or Vertical orientation.
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C H A P T E R  15
Changing Your Site’s 
Style 15
SiteStyles are sets of thematic elements you can apply to your site. Some style 
elements are graphic and others affect the appearance of text on your pages. You 
can apply any available SiteStyles to change the look and feel of your entire site.

This chapter describes SiteStyles and how to use them, including:

• Changing SiteStyles

• Adding and removing SiteStyles
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What Is a SiteStyle?
A SiteStyle is a collection of graphic and typographical elements you can apply to 
every page in your site to change its look and feel. Your site’s SiteStyle gives it a 
consistent look that survives variations introduced by your site visitor’s browser. 
When you change the SiteStyle, NetObjects nPower automatically updates every 
page in your site with the new look.

Changing SiteStyles
Navigation banners, buttons, text, lists, and other site design elements obtain their 
images and text attributes from the SiteStyle assigned to the site. When you apply a 
different SiteStyle, NetObjects nPower automatically applies style elements 
throughout your site. For example, it replaces all the buttons in your navigation bars 
with images from the style you specify, while maintaining the relevant links.

To apply a SiteStyle:

1. In Page view, right-click in the nPower window and select Choose SiteStyle 
from the shortcut menu.

The Choose SiteStyle dialog appears.

List of 
available 
SiteStyles

SiteStyle 
preview

2. Click a SiteStyle name from the Active SiteStyles list in the left-hand pane of 
the Choose SiteStyle dialog.

A thumbnail of the SiteStyle appears in the right-hand pane.
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3. Click Preview in Browser to view the SiteStyle in a full-screen browser 
window.

4. Close the SiteStyle Preview window to return to the Choose SiteStyle dialog.

5. To apply the SiteStyle, click Apply.

6. Click OK to close the SiteStyle dialog.

In Page view, you see the new style elements and text attributes on the page.
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C H A P T E R  16
Managing E-Commerce 
Catalogs 16
If your site has an online store, you can use nPower to easily add or import 
products, images, and descriptions to keep your catalog up to date. Your store will 
look great on the Web, and site visitors can easily find what they are looking for.

This chapter describes:

• Working with products

• Adding product attributes, images and descriptions
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About Catalogs
Each catalog on your site includes two types of pages—a list page and detail pages. 

• The list page displays a short summary of each product in the catalog displayed 
in a format that you select. You can choose to add a thumbnail image of your 
products so that site visitors can click to see the full detail page. 
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• Each detail page can display a large image of the product. You can also display 
product attributes such as name, product number, price and weight.

When you add a catalog object to the list page, NetObjects nPower automatically 
adds the Details page for you. On the Site Navigation palette, the list page is 
displayed as a single icon that contains multiple pages.

Horizontal lines on 
the bottom of the 
page icon indicate 
multiple pages
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Working with Products
You can modify your catalog by adding products, and then setting product 
attributes, descriptions and choosing images. You can do this one product at a time 
or import a comma- or tab-delimited file. See “Importing Products” on page 188.

Adding Products
You add products on the Products tab of the E-Commerce Catalog Properties 
Editor.

1. Open the E-Commerce Catalog Properties Editor. You can:

• Double-click a product on a list page or a detail page.

• Click a product on the list page and then click Configure in the Catalog 
Properties palette.

The E-Commerce Catalog Properties Editor appears, displaying the Products 
tab.
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2. Enter in product information by navigating to the sub-tabs located on the 
Products tab.

• Attributes. Add detailed information that will identify your product, such as 
a name or part number. To assign specific characteristics such as color and 
size, see “Adding Options” on page 183.

Note: The attributes listed are determined by the store engine 
being used.

• Description. Provide your customers a brief and extended product 
description. The descriptions can be shown on the List page and detail pages 
of your catalog. 

Also, you can add product comments and keywords related to a specific 
product. This information can only be viewed in the E-commerce Catalog 
Properties Editor,

• Detail Image. Upload an image associated with the selected product. Use 
the options on the Detail Image tab to configure the image output settings. 

• Thumbnail Image. Display the product detail image as a thumbnail that can 
also link to the product detail page. 

• Related Products. Related products can be used to promote similar products 
in your catalog. You can display related items that site visitors may be 
unaware of on the detail page of a product.

Adding Options
You can create product attributes without having to add separate product records. 
For example, you can include variations, such as size or color, to one item without 
having to create additional products.

1. In Page view, display the List page or a detail page of the catalog you want to 
work with.

2. Open the E-Commerce Catalog Properties Editor.

3. In the name column, select a product you want to add options to.

4. Click on Add Option.

The Add Group dialog will appear:
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5. Enter a Group Name that will identify this group of options.

The Group Name will appear only in the E-Commerce Catalog Properties 
Editor.

6. Enter a label. If no label is entered, the label name will default to the Group 
Name.

The label will appear beside the options on the List page and detail page of your 
site. 

7. Click OK. The Edit Product Options dialog will appear.

a. Click New Option to add a value, such as size or color.

b. Click Add Another to add more values.

c. Click OK to close the Edit Product Options dialog

d. Click OK to close the Add Options dialog.
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e. The option group will now appear in the Options field.

• To edit a group and its values, highlight the group in the Options field and click 
Edit Option. See “Adding Options” on page 183

Resizing Product Images
1. In Page view, display the List page or a detail page of the catalog you want to 

work with.

2. Click an image. The Properties Palette appears.

3. Resize the image.

You can change the image size by dragging the slider on the properties palette, 
by entering the width directly in the Properties Palette, or by dragging the 
image.

• To change the image size by dragging, select the image and drag the small 
white box until the image is the size you want. When you release the mouse 
button, the image is resized. If you are on the List page, all images are 
resized.
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• To change the image size by dragging the slider on the Properties Palette, 
drag the slider to the right to increase the image size, or to the left to 
decrease the image size. A dotted line rectangle increases or decreases 
proportionally as you drag and the size of the image is displayed in a Screen 
Tip.

When the image is the size you want, release the mouse button.

• To change the image size by entering the width directly in the Properties 
Palette, type a number in the Width field.

4. Apply the change.

• If you are on the List page, click Apply to All to resize all thumbnail images.

• If you are on a detail page, click Apply to resize only the current photo or 
Apply to All to resize all photos in the catalog.

Resizing Product Boundaries
1. In Page view, display the List page or a detail page of the catalog you want to 

work with.

2. Click on the catalog object. The Properties Palette appears.

3. Resize the product boundaries. 

You can change the boundary size by dragging the slider on the Properties 
palette or by entering the width directly in the Properties Palette
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• To change the boundary size by dragging the slider on the Properties 
Palette, drag the slider to the right to increase the space or width between 
products, or to the left to decrease the space or width. 

• To change the boundary size by entering the space or width directly in the 
Properties Palette, type a number in the space or width field.

4. Apply the change.

• If you are on the List page, click Apply to All to resize all thumbnail images.

• If you are on a detail page, click Apply to resize only the current photo or 
Apply to All to resize all photos in the catalog.

Removing Products
You can remove products from the catalog on the Products tab of the E-Commerce 
catalog properties editor.

1. In Page view, display the List page or Detail page of the catalog you want to 
work with.

2. Open the E-Commerce Catalog Properties Editor.

3. In the Product Name column, select a product and click Remove,

Duplicating Products
You can easily duplicate products that share similar attributes.

1. In Page view, display the List page or Detail page of the catalog you want to 
work with.

2. Open the E-Commerce Catalog Properties Editor. 

3. In the Product Name column, select a product and click Duplicate.
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4. You will see the duplicate product listed with (copy) in the name,

Filtering Products
You can filter your product list by searching for products with similar attributes.

1. In Page view, display the List page or Detail page of the catalog you want to 
work with.

2. Open the E-Commerce Catalog Properties Editor. 

3. Click on Filter.

You will see the Product Filter dialog appear.

4. Choose an attribute to search for. 

5. Choose a parameter to narrow your search and type in a value.

6. To further narrow your search, place a mark in the check box and add additional 
parameters.

7. Click OK.

To remove the filter so that all products are displayed, click Show All.

Importing Products
If you have an existing product list or prefer to work with a .txt, .csv, or .xml file, 
you can import your products into the E-Commerce Properties Editor.

When setting up your .txt, .csv, or .xml file, remember:

• The first row must contain the row headers. The row headers will be used to 
match the row to the appropriate field in the E-Commerce Properties Editor.

• The image path is relative to the folder which contains it. 
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• Up to 16 fields can be imported and matched to the fields listed in the E-
Commerce Properties Editor. 

To import products into the E-Commerce Catalog Properties editor:

1. In Page view, display the List page or Detail page of the catalog you want to 
work with.

2. Open the E-Commerce Catalog Properties Editor. 

3. Display the Products tab.

4. Click on Import.

The Open file dialog appears.

5. Browse to the file you want to import. You can import:

• Tab Delimited Files (.txt). These are plain text files using tabs to separate 
each text string in a row.

• Comma Delimited Files (.csv).These are plain text files using commas to 
separate each text string in a row.

• Extensible Markup Language Files (.xml). These are plain text files using 
tags to separate each text string in a row.

• Excel Files (.xls). These are Microsoft Excel spreadsheet files.

6. Click OK. 
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The Map Columns dialog will appear.

E-Commerce 
Catalog Properties 
editor key fields

Imported file 
headers

7. In the Map Columns dialog, match a Key field from the E-Commerce 
Properties Editor by choosing a corresponding field from the imported file in 
the drop-down list. The drop-down list will display the column headers, which 
is the first row in your imported file.

If you matched the file headers in the imported file with the Key headers from 
the E-Commerce Properties Editor, you can click “Match” and have NetObjects 
nPower automatically match the fields.

8. Click OK to close the Map Columns dialog.

In the E-commerce Catalog Properties Editor, you will see the imported products 
listed on the Products tab.

Removing a Catalog
1. In Page view, display the list page of the catalog you want to remove.

2. Select the catalog object and delete it.
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Publishing Your 
Changes 17
After updating your site, you’re ready to publish the results. NetObjects nPower’s 
built-in FTP program processes the files for your site’s pages and associated assets. 
NetObjects nPower then transfers the generated files to the server so that your 
changes are live on the Internet. Your site is also stored in NetObjects nPower’s 
Versions Manager, which allows you to work collaboratively with NetObjects 
Fusion designers and also provides a safeguard against unwanted site changes.

This chapter describes:

• The publishing process

• Previewing your changes

• Publishing your changes

• Using the Versions Manager
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The Publishing Process
The NetObjects nPower publishing process involves two basic steps: previewing 
your changes and then publishing the site to the Web.

A typical scenario is to preview your site so that you can then open, run, and test 
the site in your browser without connecting to the Internet. When the site is exactly 
right, you’re ready to publish it.

Caution:You must use NetObjects nPower to transfer your site’s and 
asset files from one location to another. You cannot move 
generated files, nor can you rename the files in Windows 
Explorer. Renaming the files or moving them to a new location 
breaks links because the file locations are different than those 
specified in the generated HTML files.

Previewing Your Changes
After editing your site, you should preview it in your browser to check that the site 
works as intended. When you select Preview from the File menu, NetObjects 
nPower launches your browser so you can view the site and see how it will appear 
to site visitors on the Web. 

If, after previewing your site, you make changes to the site, preview the site again. 
Depending on the complexity of the site, you may need to preview several times to 
get the site working as desired. Then, when the site works perfectly, publish it so 
everyone in the world can appreciate your handiwork.

Publishing Your Changes
After you have previewed your site and are satisfied with the results, you are ready 
to publish it so that your changes will be live on the Internet.

1. From the File menu, choose Publish.
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The Publish Site dialog appears.

Select which pages of the site 
you want to publish

Verify that the correct Publish 
Profile is selected

Click to open the Versions Info 
dialog and enter information 
about the version

2. In the Publish files to drop-down list, choose the publish profile for your site.

3. In the Pages to Publish drop-down list, specify which pages of the site that you 
want to be published.

• Select Entire Site to publish all of the site’s pages and assets.

• Choose Current Page only to publish only the page that is active in Page 
view.

• Choose Select Pages to select specific pages of your Web site to be 
published.

• Select the Publish changed assets only check box to publish only those 
assets that have changed since the last time the site was published.

Note: If you add a page to your site, make sure you re-publish the entire 
site and not just a site section so all the links are updated.

4. Click Advanced to open the Version Info dialog to enter notes about the site 
version to help you identify it should it need to be restored. NetObjects nPower 
stores a copy of your site in its Versions Manager each time you publish. 

5. Click Publish.

NetObjects nPower uses its internal file transfer program to transfer the site to 
the Web server.

6. The File transfer is complete dialog appears. Click OK to close the dialog.
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Your changes are now live on the Internet

Using the Versions Manager
NetObjects nPower’s Versions Manager allows you to work collaboratively with 
NetObjects Fusion designers who can access the versions repository and maintain 
your site.

The Versions Manager also provides you with a safeguard against unwanted site 
changes because you can roll back a previous version of your site. This feature 
provides you with added security when editing your site because you can easily 
restore your site’s previous content in the event that you are not pleased with the 
results after making changes.

Creating a Site Version without Publishing
NetObjects nPower automatically stores a site version in the versions repository 
each time you publish your site, but you can also create a version any time during 
the site-editing process.

1. To create a site version, choose Versions Manager from the File menu.

The Versions Manager dialog appears.

Click New to create 
a site version

2. Click New.

3. In the Details fieldset, enter information, such as the version name, author, and 
description, that will help you identify the specific version should it need to be 
restored.
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4. Click OK to create the site version in the versions repository.

Restoring a Version
If you modify your site and are not pleased with the changes, you can restore your 
site’s previous content with a few simple clicks.

1. To restore a previous version of your site, choose Versions Manager from the 
File Menu.

The Versions Manager dialog appears.

2. Click the name of the Version you want to restore from the Version Name list.

Select the name of 
the version you 
want to restore

Click Rollback to 
restore the site 
version

3. Click Rollback.

nPower retrieves a working copy of the site from the versions repository, and 
the Save Site As dialog appears.

4. Enter a name for the site in the dialog and click Save.

5. NetObjects nPower opens the site for editing so that you can review the site and 
make any needed changes. 

6. When you have finished editing the site and are pleased with the results, follow 
the steps for “Publishing Your Changes” on page 192.
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Working with Character 
Sets 18
In the past, most computers used the same character set to represent upper and 
lowercase English language letters, number characters, and punctuation characters. 
This character set is known as ASCII. However, ASCII is a very limited character 
set, unable to support a variety of alphabets. To accommodate computer users 
worldwide, different character sets were developed. These new character sets are 
often identified by a number, such as code page 850 or ISO-8859-1.

Character sets are composed of code points, which are the numbers assigned to 
characters that the computer uses to identify the character. For example, in ASCII, 
when you type a capital A, the computer sees its code point, which is the number 
65; if you type a B, the computer sees a 66. Both the code page 850 and the ISO-
8859-1 character sets include accented characters, but 850 uses the code point 130 
for the character é, and 8859-1 uses 233 for the same character. To eliminate this 
confusion, an effort is underway to create a universal character set that includes 
every character from every language. This character set is called Unicode.

Characters display correctly in NetObjects nPower because they are stored in 
Unicode. When NetObjects nPower publishes or previews a page, it converts the 
text from Unicode to the character set selected for the site or for the individual 
page.

Suppose you type Greek characters on a page, set the page character set to Western 
European (ISO-8859-1), and preview the page. Because their particular code points 
do not have equivalents in the Western European character set, the Greek characters 
may appear as question marks. If you want to guarantee that the Greek characters 
on the NetObjects nPower page display correctly when you preview or publish, you 
should choose a character set that includes Greek characters. This character set is 
then inserted in the charset parameter in the generated HTML META tag, which 
tells the browser how to interpret and display the characters.

If you have a page that contains languages that use different character sets, for 
example, English on the right and Greek on the left, to guarantee that all characters 
will be interpreted correctly by the browser, you can use Unicode (UTF-8) or two-
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byte Unicode (UCS-2) as a character set for the page. Remember that Unicode is 
evolving; it is not complete yet, but it does include code points for most characters 
in languages commonly used on computers today. Note that only Netscape 4.x and 
Microsoft Explorer 4.0 and up currently support UTF-8, and only the most recent 
versions of Netscape and Microsoft Explorer support UCS-2.

Available Character Sets
The following character sets are included with NetObjects nPower:

• Baltic (CP-1257)
• Central European (ISO-8859-2)
• Central European (Windows-1250)
• Chinese Simplified (GB2312)
• Chinese Traditional (BIG5) 
• Cyrillic (ISO-8859-5)
• Cyrillic (KO18-R)
• Cyrillic (Windows-1251)
• Greek (ISO-8859-7)
• Greek (Windows-1253)
• Japanese (EUC-JP)
• Japanese (ISO-2022-JP)
• Japanese (SHIFT_JIS)
• Korean (KSC5601)
• Turkish (ISO-8859-9)
• Turkish (Windows-1254)
• Unicode (UCS-2)
• Unicode (UTF-7)
• Unicode (UTF-8)
• Western European (CP437)
• Western European (CP850)
• Western European (ISO-8859-1)
• Western European (ISO-8859-15)
• Western European (Windows-1252)
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The following character sets are not included with NetObjects nPower, but are 
supported once installed in your operating system. You can download language kits 
at www.microsoft.com or install them from your Windows NT installation disks.

• Western European (CP-437)
• Western European (CP-850)
• Central European (CP-852)
• Cyrillic (CP-866)
• Greek (CP-869)
• Greek (CP-737)
• Turkish (CP-857)

Setting the Character Set for an Individual 
Page
You can override the default site character set and choose a different character set 
for individual pages.

1. In Page view, right-click on the page and select Page Character Set from the 
shortcut menu.

2. Select a character set for the page from the Page Character Set drop-down. This 
character set will be applied only to this page.
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URL and Page Name Character 
Requirements
The characters in a URL are limited to those represented in lower ASCII, which 
includes uppercase and lowercase English letters, numbers, and common English 
punctuation. You cannot use accented characters or other special characters in a 
URL.

You can, however, name pages using accented characters. The names on the banner 
and buttons display in the correct international form. In Publish view, however, file 
names, page names, and folders change to names with unaccented characters.

For Japanese, NetObjects nPower uses the ASCII characters that are normally 
converted to a Japanese character. For other Asian languages, a numeric file name 
is assigned. For European languages, NetObjects nPower strips out the accents; the 
words look the same but without accents. For example, if you name a page été in 
Site view, in Publish view it is listed as ete.html. 
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Locked Content 39

M
mailto links 134, 141
margins 156
MasterBorders

changing margins 157
defined 35, 156
modifying 157
selecting 157
showing/hiding 35
sizing 38, 157

META tags 28

N
naming

Layouts 153
objects 44

navigating 8
between pages 36
Site Navigation palette 37

navigation bars
highlighted buttons 165
primary and secondary 165
rollover buttons 165
setting border width 162
setting button spacing 162
setting display options 161
setting targets 172
setting type 166
using 160

NetObjects Fusion
navigating 8
updating 18

numbered lists 72
start value 74

O
Object Tree 44

using with tables 119
objects

adding 40
adding to Layouts 154
aligning 45
copying 45
creating embedded 52



distributing 45
dragging and dropping 41
embedding 51
formatting 68
moving 45
naming 44
pasting 45
placing 40
resizing 44
selecting 43
showing/hiding indicator icons 35
showing/hiding outlines 35
sizing 44
snapping 47
updating multiple instances 41
wrapping text around 53

options
preview 15

ovals, see shapes

P
padding 66
page names

character requirements 200
setting 172

Page view 6, 33
pages

adding 23
character set 199
child 21, 22
copying 23
deleting 24
Don’t Publish setting 28
margins 156
moving 24
naming 27
navigating 36
parent 21, 22
pasting 23
selecting 22
setting background 55, 120, 127, 170
setting Management properties 28
setting properties 27
showing/hiding Layout and MasterBorder labels 35
sibling 21, 22
title in browser window 27

palettes
color 10
properties 7, 14
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showing/hiding 35
parent pages 21, 22
photo galleries

adding captions 103
adding photos 96, 182
adding text 103
adding titles 103
arranging photos 98
deleting 109
editing captions 103
editing properties 102
editing titles 103
formatting thumbnail titles 108
navigating photo pages 109
removing 109
removing photos 102
resizing photos 100

photo pages
navigating 109

pictures
adding 82
changing on one button 169
creating borders 89, 90
cropping 88
rotating 87
sizing 85

png files 82
polygons, see shapes
Portable Network Graphics

see png files
Preferences dialog, see Application Options dialog
previewing

choosing browser 15
setting scope 16
setting window size 16

primary navigation bars 165
Project List 20
Properties palette 7
publish 192
publishing

locally 192

R
rectangles, see shapes
relative links 142
resizing

objects 44
right-click menus 9
rotating



pictures 87
rounded rectangles, see shapes
rulers

showing/hiding 36, 47

S
saving sites 14
scaling pictures 85
Script icon 35
secondary navigation bars 165
selecting

Layouts 152, 153
MasterBorders 157
objects 43
table cells 128
text 60
text boxes 50
tools from flyout 8

shapes
drawing 112
editing lines of polygons 113
varying curve of rounded rectangles 113

shortcuts
menus 9

sibling pages 21, 22
Site Navigation palette 37
Site view 19

SiteStructure 21, 22
sites

opening last automatically 14
saving 14
structure 21, 22

SiteStructure 21, 22
SiteStyles

applying 176
defined 176

sizing
columns in tables 121
Layouts 154
MasterBorders 157
objects 44
pictures 85
rows in tables 121
text 61
text boxes 54

smart links 134
creating 138
defined 138
types 139
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spans
creating 70

spelling checker 76
Standard toolbar 41
structural links, see smart links 134
symbols

inserting 75

T
tables

adding 118, 129
background 120
border thickness 120
cell padding 118
cell spacing 118
column width 125
deleting rows and columns 123
identifying objects 119
inserting rows and columns 122
merging cells 123
row height 125
selecting cells 128
selecting rows and columns 125
setting cell properties 126, 128, 130
setting row and column properties 125
setting table properties 119
sizing cells 127
sizing columns and rows 121
splitting cells 123
working with cells 125

targets
navigation bar 172

text
adding 58
adding to photo gallery 103
applying styles 70
assigning font styles 61
bulleted lists 72
checking spelling 76
copying and pasting 59
dragging and dropping 59
finding 77, 78
formatting 60
inserting symbols 75
numbered lists 72
Paste Special 59
searching 77, 78
selecting 60
setting color 61



setting size 61
spans 70
typing 58
word count 79
wrapping around objects 53

text boxes
adding 50
container 49
embedding objects 51
selecting 50
setting background color 55
setting minimum height 54
sizing 54

text navigation bars 160
text styles

applying 70
modifying 70

thumbnail image 83
toolbars 8

flyouts 8
hiding/showing 8
showing/hiding 35

tools
Selection tool 40, 43
sticky tools 40
toolbars 8
using to add objects 40
Zoom 8

transfer site files 192

U
Universal Resource Locators, see URLs
URLs

external links 140
protocol 140

V
views

Page view 33

W
Warning icon 36
What’s This? popup 9
window size at startup 14
word count 79
wrapping text around objects 53

Z
Zooming in/out 8
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